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First steps 1

1 First steps
1.1 First steps with AquaSoft ® SlideShow

Start the program, then select an empty 4:3 slideshow in the Welcome dialog.

Before you start with your work switch to View -> Layout. Here you will also find the Timeline.

1. Adding images

S B G B T T o

| |
Mew  Open.. Ssve | Add | Music Settings | Blay o 0o | Output | Search | Defoult Storyboard Imagelist Toslbox
] Defaul m— Al
£l
3 ) |i||
SULY
Chapter Collage Irnage Patticle
0\
[1& T =
Placeholder  Sound Text Widea
Bl B>
&
Colored Pause Play White,
background transparent
= Arirmations
. z F T [ W el
| —————

4 W b W 13 Ge 03 08 P W W a0 a3 3 M 3

Click here taadd backgro
‘Mote: the musictrack remains empty aslong as the w doesn'tcontain ary images

Duration: 40.0 sec | 07.5.01,

You can select and add photos via Add -> Images. You also can add whole directories via Add -> Directory.
The selected images will be displayed in the Timeline. By using Edit -> Sort you can get the images into a
certain logical order, e.g. by their EXIF-exposure date. Naturally, you can sort your images manually, as well.

2. Adding background music
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Slideshow settings

E| Slideshow
Main settings

i Slideshow flow

| Endof slideshow
Tranzitions

Mu i settings

. Descnptlon
- Logo
B SlideShow-Flayer
- Software Player
Standard Player [Di... |

b

T

=l Background songs
[r] G| o B
1. ﬁ O:3MediatMusichadtisthin -Titell1. wma

2 ﬂ O:iMediadMusichbmisth02-TitelD2. way
3 ﬁ O:vMediatMusichAisti03- Tikel03 way

IU,D s8e 3_‘ Stait-poaition

|_U_D e 5 Enc

In = :_\

|_U_D |E o5

|UD°ec, }nl 3

Background music

X

Cancel

Music enriches your life and your show. Via Add -> Background music you can select music titles by
clicking the Plus-button. The order of the titles can be changed by moving them with the mouse.

Removwe titles from the list by clicking the Trash bin-button. If you select a title you can adjust its settings.
Then click OK. The music titles will be displayed in the Timeline.

3. The show can begin

't%

Same | Add

| B Defaule

M i’@ 1]
| Music Sattlngs

O

| Output | Search

[T

Siees

Chapter  Collage Particle

[1& T =

Image

Placeholder  Sound Text Wideo
>
SRE
Colored  Pause Flay ithite,
backaround transparent

| Animations

WA @ @ a3

St

—
| Default anrylma!d Imageﬁst Toolbox

B

This quick you can see results. In two steps you added pictures and music, and now you can play your show.
To do this click the Play-button in the menubar or F9. Transitions are selected randomly and each time you
play the show your images have a different transition.
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First steps 3

That's not enough yet? You want to specify the display duration, enter text and define transitions yourself? No
problem with AquaSoft ® SlideShow!

4. Image properties

Object Settings
il]hjett settings

| [} show object

Duration: 5200.51 SeC :_|

[¥|Leave in place after replay

|El Texk

Y T g

i=I File name

d:'\I':'i;a;:l.\;a.'l,.Imaga.s'l,u-'ng_lug-ISID%ﬁ;t.:jpg

(= Transition

ERandom transition - | | @ Adjust |
= Background

Fill: !Automatic {on; | G 3
Fill color: E]
= Position

Aspeck ratio:

Alignment: |__.i_.£E_Ijt_8r

|7 | Ratate in direction of movement

Select the first image. On the right side you will find the image properties. Here you can assign a fixed
transition, text and comments to the image. You can also customize the duration of the image.

@ Ifyouwant to change the duration of several images at once select all images that are to be edited
via Ctrl+A in the Image list and change the value of the duration. It will be assigned to all selected

] images. Under Program settings you can also change the default value for the duration. These
changes then apply to all images that have Use default duration checked.

5. Specifying transitions

Holling up [one side]

 Tranisition:

‘_Fi_olﬂr)gup [one side] - |

Duration of tansition: [E-DE sec 3

Duration of one box: ﬁ_DE $ec T

Quality: —H——1m

A (R
[¥] Alphablending

7] Invert effect

|E 0K | |; Cancel 1

If you don't want to leave the transition to chance select the one you want from the list. If you click the Adjust
button you can further edit the transition properties.
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e

With the = -button (... from here) in the menubar you can play the show from the paosition of the currently

selected image.

6. Text fade-in

@‘ T 7ot | :"]

= Font

E'I Arial

| = Style Alignment

AaA =E=|-—

= Text

ABCUEfGH) - 26

- [l

IYacation 2010

=| Effect

A @ an S Border color: |- | '|
Animation: -
\Ahablending *] e Tt

. Rotation around text Show text with image

— center

Under object settings for images you can find the
tab Text. Here you can enter text to accompany
the image and also add formatting. The text can
have an animation applied as well. After clicking the
Edit -button you can customize this animation and
specify whether or not to leave the text in place after
playing the image. If you activate the function Show
text with image the text will be displayed together
with the image and will not be animated separately.

8. Ken Burns Effect

7. Commenting images

EEE © |

= Sound

QuiMedialMusicl Artistl 01 -Title0 1, wma |Z| !L_*l
| A Record \ Duration; 03:19.904 ‘ﬁl
= ¥olume

Yolume: 100 Yo =

[¥] Fade background rusic {Settings)
mla! behavior
Start position: UUUsec =
170 Adjust display duration ta sound duration
171 Continue sourd after end of image
17 Fade-out sound after end of image

On tab Sound you can record a comment via a
connected microphone. To do this click the Record -
button. The duration of the image will be automatically
adjusted to the comment. Alternatively you can assign
a specific sound file to the image. Click on the yellow
folder to select the file.
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RIS

. from here | Qutput | Search

N

Save | Add | Music  Settings

E

3 H
Mew  Open .. I TBTie St Twaaan el

Blay

%] show object
e = |
Duration: 5.00sec 3 |

1¥] Use default duration (Settings
[¥ILeave in place after replay

=
EY s 5

| = File name ‘

[ Movement paths

| B Hovement Daths -
Delete xploslun Ken Bu IFn:
mDvement

2%

Ken Burns {in
2)

Ej
il

O:\MedialImagestimg_1930704.1pg '

= Transition —

| |Random trans '\ 3 @Adjust |‘

| =l Background

Fil: |Automatic - | &

Fill color:

SlideShow provides predefined Movement pathsin the Toolbox. Among them you can find the Ken Burns
Effect. Drag the Ken Burns Effect from the Toolbox directly to an image in the Timeline. Now play that
image. There are many more options to animate images with zooms and camera pans. You can find more
information about this at a later point in this manual.

9. Image effects

|1 Show object

Duration: [5.00sec  + |
[¥] Use default duration {Settings)

|| Leave in place after replay

[E lext Sound | 2 Transp M4
[Ea N cRRva: B 5

| = File name

o
Polaroid Polaroid Severed
{rotated)

da o &=

Shadow {normal} shadow (strong) Shadow
(unobtrusive)

i

OrMedialImagestimg_3357562.jpg

| =l Transition

| [Rendomirans - | [ [@adus |
|5 Background

Fill; [automatic - | €&

Fill color:

Duration:

Just as easy as adding a Ken Burns Effect you can assign other special Image effects. To do this go to
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Image effectsin the Toolbox. Drag an image effect to an image in the Timeline. Click on this image and you
will see it in Layout Designer with the effect applied.

Image effects influence how an image is displayed. They are not transitions. Those you can find in the image
properties (Box 4 on this page) and under Transitions in the Toolbox.

10. Creating a collage

] | |
|| fd
o Save | Add | Busic  Setfings

Gy

mEe Tz
re | Output | Search |

Default  Storyboard  Imagelist  Toolbox

| By .6

0sec 7 |{E

[} Show object

Duration: [5-00sec 7 | Distance; |0.00 sec
[7] Use default duration {Settings)
[¥]Leave in place after replay
- (Do ot P
I m | =i File name 4
[ - —— oo S oo —_—
3 i

- o O:\Medis\Imagesiimg_2160037.Jpg
Video )

Text

S Transition 7|

L 2 W 2 W 8 A AW A WA e WA W o8 E

=T

In the Toolbox you can find the Collage-object. It allows the display of several images and texts at the same
time. Simply drag it from the Toolbox to the Image list to insert it into the slideshow. Now select those
images from the Image list that you wish to include into the collage and drag them to the Collage-object.

Expand the collage so that the images are displayed. Under object settings for collages you can select the
transition you want to apply.

11. Editing a collage
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(T ———

‘ lll ::: " . Il
Open.. Save | &dd | Music Settings P\ay

oM T3

.frambere | Output | Search | PIRIE Sontose Imagaﬁst Toalho

\7}‘ JE ‘\D@s\ . |%% | | Tire ratk: !U sec T H h'E[t Sein-I

%] show object
Durstion: [5.00sec 3 | Distance: 0,00 sec
i’;\ Use defaulk duration {Settings
[¥|Leave in place after replay
? == m——

o T——
§liﬁnm Baw - % - [
m | = Style Alignment

| [A]A

[1&(T|=

Placeholder  Sound

Text Wideo == | = =

14
D015 min

0015 min =
o Ll 12 {71 14 i

NH&'NNE&‘NNﬁ‘ﬁ@‘ﬂ@lﬂﬂlﬁﬁblﬂﬂﬂﬁh"i

Durakion:

Select the first image in the collage and resize it in Layout Designer by using the position frame at the edges
of the image. Now position the image. Repeat these steps with all images in the collage. In the Toolbox you
can also find the Text -object. Select the last image in the collage, then click the Text -object to insert it. The
text will be added as the last object of the collage. On the Text -tab in Object setting you can add and format
text. Now position it. Select the collage from the Image list and click the ... from here -button to play the
collage.

12. The powerful chapter

min

g gl ﬁ gl g i

One image track is not enough for you? Then you can utilize the chapter. In contrast to the collage images and
text inside a chapter don't lose their own animations and can also be temporally offset. Insert a Chapter -object
and drag two images into the chapter. Open the chapter by clicking on the Plus -symbol, select the last image
in the chapter and then double-click the Text -object in the Toolbox to add text after the image. To create a
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new track mowe the second image in the Timeline under the first. A red bar appears, which helps you with the
positioning. Now move the Text underneath the second image and assign an animation to the Text -object via
the Object settings.

13. Temporal fine tuning

| Timeling
| e

i
| @min

Extend the duration of the first image to 10 seconds. To do this simply drag the right edge of the preview image
farther to the right. Then mowve the second image to the right also using the mouse. Extend the text and mowe it
inside the Timeline a few seconds to the right. Select the Chapter and click the ... from here -button. The
text appears after the first image has been displayed for a few seconds and will be shown with an animation. In
this example the text will also be shown in the second image.

14. Chapters can do even more

ct settings
Show olrject

[B00sec | Distance: 3.00sec T

[T Use defau duration (Settings)
B lacs after veplay

Paride

uoaTe

!
© Placsholder  Sound T video o ||| Fillcolor:

h

Chapters offer a variety of other options. Decrease the size of the second image inside the Layout Designer.
In Object settings deactivate the function Fill. Now move the image a little inside the Timeline. Play the
chapter again using ... from here. This way you can easily create many different picture-in-picture effects.

15. The chapter on a DVD?
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The chapter also senes to divide the show into different parts. It helps to keep the oveniew in large shows. In
addition these chapters can be utilized in a DVD-menu later. (Feature of SlideShow-Manager, which is part
of SlideShow Ultimate and Blue Net.)

After you finished the creation of your show you can create a DVD for the DVD-player. This isn't necessary if
you wish to continue to play the show on the PC.

16. Burning

Under Wizards you can find the SlideShow-Manager. Here you can specify which menu to use to create
your DVD. Select a template, then go to Project -> Burn project. The Video-DVD is for the DVD-player. A
self-starting CD/DVD for PC will be created under PC show.

If you're using SlideShow 7 Premium select Video Wizard to create a DVD for DVD-player. The CD/DVD
and Archive Wizard creates a self-starting CD/DVD for PC.

The conwersion of a slideshow into a video can take some time. After that you can put the burned DVD in your
DVD-player and start the show.

Now you've created a slideshow with effects and background music. Your family and friends will be impressed.

Naturally, there is much more to discover, and you can now start with experimenting with the multitude of
other possibilities in AquaSoft ® SlideShow, like editing images, using zoom functionality, recording
comments, burning CDs/DVDs, etc.

1.2 Program overview

Structure of the user interface

AquaSoft ® SlideShow includes several tools to edit your show. In the following graphics you get an oveniew
over the available controls. We will talk about objects often. All elements that can be added to a slideshow,
e.g. images, text, music or collages, are objects.

|Q The description of the controls is given with respect to the Layout view. You can select it via View ->
Layout.
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B o e i T 5 T2 28
e | Output | Search | Default Storyboard  Imagelist  Toolbox
| Cbiect Settings. B4 x|
| B Defall m— Al
=Y 2/
chaprer coldT g G broag P Layout designer Object settings
[T =
|
Placehalder  Sound Text Video
Colored Pause Play wihite,
background transparent.
| B Animations T
I ¥ [ ]

Timeline

howdnesn'trontain ary images

‘Mate; the musictrack r

The toolbar

£ig s Ultirmate [T 3]

File Edit Sl idd  Extr: Wfizards Workspace Help

D@ Bl B @i B s

Hew Operi..,  Save | &dd | Music  Settings | Play .. fram here: | Output | Search | Default Storyboard Imagelist  Toolbox

D =| Creates a new empty show.

@ Opens an existing show.
Saves your show.

Adds images to your show.

Opens the slideshow settings. The settings only apply to the currently opened show.

Plays your show from the beginning.

7
J‘j Opens the dialog to add background music.
>
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u'zj[;J Plays your show from the current position.

Opens the Export Wizard.

Allows searching for text, file names and keywords inside your slideshow.

i Loads SlideShow's Layout view.

EEE Loads SlideShow's Storyboard view.
g | Loads SlideShow's Image list view.
E Loads SlideShow's Toolbox view.

The Layout Designer

The Layout Designer is your preview window. Here you can see how images and text will be displayed on the
monitor.

f.'@.@ I“_gf;lgg'?,; D@Em | Time mmark: \Ec_il. =]

The following icons are available in Layout Designer:

H-*.‘,H Zooms into the preview in Layout Designer.
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v,

= | Zooms out of the preview in Layout Designer.

i | Sets the view/window size back to its normal size

|__|] Toggles the raster that objects can be magnetically aligned on

Zoom and camera pans can be set in Layout Designer by defining movement marks. You can find the
necessary buttons in the toolbar of the Layout Designer. They will be explained in the respective chapters.

At the bottom edge you can find the navigation controls for replay in Layout Designer.

- (5 | ' T L Wy W

_"] Replays the slideshow from the beginning.

L §

Replays the slideshow from the selected object.

The navigation bar changes after the start of the replay.

“ i fod o B el | Currenttime: 00i13:911

m Pauses the replay.

!] Ends the replay.

If you pause the replay additional navigation options become available.

= boo (jo! ol o#) | Curenttime: 00:14.692

__] Continues with the slideshow.

H_‘] Jumps to the previous object.
I"_] Jumps to the previous single picture. This way it is possible to carefully check separate sequences.
i] Jumps to the next single picture. This way it is possible to carefully check separate sequences.

'i] Jumps to the next object.

There are two distinct areas in Layout Designer - the visible and the invisible area.
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[ TG NG, S R %‘{? - el | | Time rmatk: iEI sec o |: B

invisible area

visible area

R T R R

13

The \isible area represents your monitor. Everything inside this area will be displayed later on the monitor. The
invisible area is outside the visible area. We need it to be able to let text, images and other objects fly into the
visible area. It means that movements can already take place outside of the visible area and then continue to
move into the visible area. This way you can for instance let text run from left to right over the screen. The

magnifier icons can be used to increase or decrease the size of the visible area.

The Object settings

Each Slideshow object (image, chapter, collages, ...) has certain properties that will be displayed when you
select the object in Image list, Timeline or Storyboard. In the following graphic you see the settings for an
image. Objects and their properties will be explained in more detail later in this documentation.

bbje-:t Settings

|Object settings

[ [} Show obiject

Duration: 5200.51 sec _:_|

DO oL T g =

=l File name

d:iI\‘ie;:l.\él.lmage.s‘ul.'ng_l.g..S.U%.U;l.‘]pg ; @

= Transition

»

- |7[“_B Adijust |

= Background
Fill:
Fill color;
[= Position
Aspeck ratio:

Alignment:

[~ Ratate in direction of movemsnt

m

[auromatic ton; ~ | &
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14 AquaSoft SlideShow - Help

You can specify the duration of your image and its transition, for example. On the Texi-tab you can add and
format text. And on the Sound-tab you have the option to assign a special comment or sound to your image.

The Toolbox

The Toolbox is the place where you find all the objects that can be added to a slideshow. You can click on
them and drag them with held-down mouse button to position in the Image list. This process is called
drag&drop. By double-clicking an object it will be added at the end of the show.

e
|5Iideshu:|w abjects &%
| = Default
¥ |
\ v % |
e a1
Chapter Caollage Image Particle  Placeholder  Sound
I |
Text Videa Calared Pauze Play WWhite,
background transparent -

When you click on the Transitions-tab in the Toolbox you find a large selection of pre-defined transition effects.
Click on a transition and you will get a small preview of the effect. If you want to assign a transition to an image

drag it with held-down mouse button to the image (drag&drop).

| sideshow cbiects

Delete Random  Alphablending Alphablending Alphablending
kransition transition (gradient) (plasmna) )
A I lli |
Alphablending Arrom Basket Blinds EBlob

star]

| & Transitions Pal

r |
f!' —l
& &

The Timeline

The Timeline displays the temporal flow of your slideshow and all its images, texts and musical scores. By
using Chapters you can create multiple tracks. Images and sounds can be spread over these tracks inside
the Chapter. You can find it in the Toolbox on the tab Slideshow objects. Here you learn how to create

multiple tracks.
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There are two sliders in the bottom-right corner that allow to change the size of the time display and the height

of the objects.

The Storyboard

Here you can switch to the Storyboard. It shows a small preview, called thumbnail, of all images in the show.
This makes it easier to find a certain image in case your show grew rather large. Here too you can change the
order of the images by moving them with the mouse.

Storyboard

uiliit=l 1= Storyboard

alkpapier_bg_4x3.jpg

Image effect ideas

‘intage photo

shutterstock_593520..,

rizing: SepiafBorder: Wit

shukterskock_ZS0965, .,

[ ]

shutterstock 261315,

Colorizing: Black/

shutkerstock_ZS0965, .,

N

Sepia photo

Qriginal

=

=

N

N

Cross photo

Puzzle

N

Graphic

Use the slider in the bottom-right corner to specify the size of the thumbnails.

N

Optimization + Objects
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The Image list

All objects of your current slideshow are displayed in the Image list. In addition, further useful information about
the objects are displayed as well.

Start time Duration  File Size File D ate Settings Track Kewwords EXIF File name
- & @& 1, graybg.jpg 00sec  1,Zsec  23.518 01.05, 2008 Datalg...
ié! v 1Y 2, Flash 1,2 sec 2,5 sec
Pl W t 1. Spicy.ipg 1,2 5ec 2,5sec  41.916 01,05, 2005 1 Dakals...
; o [ & 2 blacklx1.qgf 1,2 sec 0,5sec 43 oi.05.z2008 T z Datalh. ..
l?:."- v 14 3, Flash 3,7 sec 2,5 58C
¢ W & 1 Peach.jpg 3,7 sec Z,5sec 49,179 01,05, 2005 @ 1 Datalp...
Lo W @ 7 blackixl.gif 3,7sec 0,5sec 43 01.05.2008 e 2 Datalb. ..
—] v @4 4. Flash 6,2sec  2,9seC
) oW @& 1, Horses.jpg 6,2sec  Z,5sec 34731 01.05, 2008 @ 1 Datal,..,
o W e 7 blacklxl.gif 6,Z2sec  0,5sec 43 01.05.2008 e 2 Datalb...
=k W [0y 4, Flash 8,7 sec 2,5 sBc
o @ 1, Portrait.jpg 8,7 sec 2,5sec 24,733 01.05, 2005 1 Dakalp...
L [ & 2 blacklx1.qf 8,7 sec 0,5sec 43 o1.05.2008 T 2 Datath. ..

Here you can see the start time and duration of the objects. For images there is an entry for file size, file date
and file name. Under Extras -> Program settings -> Image list you can select the columns that you want to
be displayed.

A check mark in the EXIF column means that the image contains EXIF data (e.g. exposure date, camera
model and image resolution). These can be displayed in AquaSoft ® SlideShow. More information about this
can be found in chapter variables.

Another important column is Track. It shows in which track of the Timeline your object is located. If this entry
is empty then your object is in the first track. But you can create multiple tracks inside a chapter, and the
column Track informs you about the object's track number. Of course you can also see this in a graphical way
inside the Timeline.

You can change the order of the images by moving them with the mouse.
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1.3 The Timeline

In the Timeline you see the chronological sequence of your show. It informs you when an object will be
replayed.

W

@ @A @ @ @ @ @

Images, text, collages and videos can hawe different ways to present them. So can images get camera pans,
movement paths, transitions and text. The Timeline shows you what kind of animation an object has been
assigned.

There are:

Transition

Text without animation
Text with animation
Image effect

Movement path

BEESEEE

Camera pan

You can also see the file name and duration in the Timeline. The sliders in the bottom-right corner allow you to
adjust how much you wish to see.n.

By clicking the a icon the context menu for the object will open. You can use a right-click on the object
instead to achieve the same.
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Cut

Copy

Remove

B0 P

Pazte

Ohject zettings

i i Caption

Editimage

Select tranzition
Select text animatian

Record gound

Set camera pan

Set movement path

During the replay of a slideshow in Layout Designer a blue line in the Timeline marks the current replay
position.

TR U | |

This line "runs" with the show. You can mowe it after you paused the show.

You can change additional settings for the Timeline under Extras -> Program settings -> Timeline.
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Program settings

() Main settings

Record sound
Sound system
< Confirmations

¥ 3how hundreths of a second

Flug-ins
Add files = Music track
User inkerface = = = .
Temporary Falder Height: [12__ - lpke ElHdE s biadk
- Language = Display
Auto update =
|| Show hints

x

19

Style: |Raunded
CO{DYD Burner ¢ jrocniced
£ Autosave 1= Edit
El Panel =L i
e |¥|Use ather objects as snap guide | Use time raster
Storyboard
Layout Designer Snap distance: ELID g . pixels Time raster: 'IDD ng_c___;__‘
Imagelist
OK | ‘ Cancel | | Help

Here you can specify the snapping behavior and the look of the Timeline.

If you want to position an object exactly below another object or at a certain point in time the snapping option
can be very helpful.

anymore in the Timeline. The Timeline displays only objects that are supposed to be
replayed. If you want to reactivate an image you can do this in the Image list or in the

@ If you deactivated an image of your show (Show object deactivated), it will not be displayed
@ Storyboard.

2 Design options in AquaSoft ® SlideShow

We recommend to first read the section First steps with AquaSoft ® SlideShow prior to the following tutorials.
There you will receive an insight into the basic functions of the program.

In the Program oveniew section the working environment of AquaSoft ® SlideShow is explained to you.
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2.1 16:9 or 4:37?

At first you have to specify the aspect ratio you want to create your slideshow in. The aspect ratio defines the
ratio between image width and image height.

Welcome to SlideShow Ultimate x

& s

crea:st;d:nslt&tx - ‘ Open slideshow

Use 7 i) Openexample
shdeShow-Master l slideshow

Recently opened slideshows:

alog at stark

If you want to show your slideshow on TV later the aspect ratios of 4:3 and 16:9 come in handy. Older CRT-
TVs only support the ratio of 4:3, while modern flat-panel TVs support both 4:3 and 16:9.

EEEEEsEEEEEEEEEEEEE

4:3

16:9

EEEsEEEEEEEmEEnEmEEEEEEEE

SUSEEEEEmEEEE

EEEEEEEEEEEEEE

JSESEEEEEEEERER
EEEEEEEEEEEEEE

If your images are in format 4:3 or 3:2 (digital single-lens reflex cameras) select 4:3 as aspect ratio.
If they are in 16:9 format select this format respectively.

In case you want to use the format 16:9 even though your images don't have this format, the images need to be
adjusted into the 16:9 format. This is not possible without "cropping” the images a little at the top and bottom.
Without this cropping it is technically impossible to display a distortion-free image.

@O0 0| T | Rkt | B2 | B | e mak 05 s PPl O TR ol 2 9 Tines nwerk: [ 05 e B PP T PRt 28 Time matk: [0 e
@ (@]
———————————— W 3‘}77777f—————————u———ff777————————[
oy i [ i L ,515 ,,,,,,,,,, E e ¢
Adjusted by Adjusted by
Initial state "automatic" cropping "automatic" stretching

What do you have to do now?
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Insert an image into an empty 16:9 slideshow.

OB O T BB T Thenak (05 C||H
O

You see the black borders left and right of the image.

Decrease the size of the visible area in Layout Designer by clicking on the —l icon. Now increase the size of

the image by dragging the handles at the corners of the position frame until the black borders disappear. At
last position the desired area of the image in the \isible area.

Now it should look similar to the next graphic:

Comanee o

You can save this positioning to a template so that you don't have to repeat this process for every single

image. To do this simply drag the image from the Image listto the Toolbox and specify a name for the
template in the now opening dialog.
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Create/Edit template

Tame: |Temp|ate 16_9

Title: iTempIate 16:9

Author: |

Description:

Activate all objects whose file names should be adjusted when using the tenmplate,

| Obiject
| [] @ 1, img_3357562.ing

h oK 1| |, Cancel .||

o=
Pin, Pin, pink Piri, red Pin, white Sun Star
lightgreen
- 2
.
o == -
] [ ] []
Stork Pine tree  Christrnas  Christras Cloud Mema
trae decoration

= Custom objects

PR

Templatz
1619

To add additional images in 16:9 format, simply drag the saved template with pressed mouse button onto the
Timeline or the Image list. The dialog to add images appears. Now select the images you want to add, and

they will be inserted with the settings of your custom template.
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2.2 Transitions

Each image in AquaSoft ® SlideShow can get a transition assigned. This can be done by changing the
settings in the Object settings window, but also via the Toolbox.

|
Add an image to an empty slideshow. To do this use the -button in the menu bar.

You can add several images at once by selecting them in the file selection dialog. Press the Ctrl-
key and click on the images you want to add.

b

ES T

Play from b

Gyl B e T2 i

| — H
© | Output | Search  Layout Storyboard  Imagelist  Toolbox

s

| Busic  Settings

&y
| & Defauit

YTy

Chapter  Collsge  Image  Parice

(1T =

Placeholder  Sound Teat Wideo
i B>
8]
Caolored Pause Play Vihite,
background transparent
= Animations

= | P T— |

Timeline - Track vi

oW Woa a3 oM M 3 PO G T S

£ e toadd backgraund music
‘Mote: the musictrack rema aslong a5 the slideshow doesn'tcontain ary images

About the Toolbox

In the Toolbox you find the Transitions-tab. When you click on a transition you will get a small preview.
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Transitil:lrls Image

| & Transitions

Delete Random alphablending Alphablending Alphablendmg
kransition transition gral:hent) plasma)
Alphablending Arrom Basket B||nl:|s EBlob
(star]

m : Ifh

Using Drag&Drop (moving with the mouse) you can now assign a transition to an image. Click the transition
with the left mouse button and hold it down. Mowe the transition to the target image in the Timeline. Release

the button when a red border appears around the image.

| © Transitions 3 -

Delete - Random Alphablending Alphablendmg

kransition kransition

.C\Iphablending Alphablending Arrow
(plasma) (star)

¢th multiple

Click on the image and then on ;l to play the image with the transition.

If you would like to assign a Transition to several or all images select these images.

All images = Ctrl + A

Certain images = Ctrl + right click on the image

Select the Transition with the left mouse key, then click right and select Apply. The Transitionwill be
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assigned to all selected images.

Transitions [ et

Delete

Alphablending  Alphablending
transition transition {gradient)

[

= ‘h_'-"*_: A

P.IphablenEIing Alphabl{
(plasma) kgl

II Increase icon size
iI Decrease icon size

S Tabs [eft

Tabs on top
Tabs right

Tabs at the bottom

Materthe musictrack re

You can see the specified transition in the Object properties of the image. There you can also change it and
even customize it. The following text will give a more extensive description.

If you click on an image in the Tim eline with the right mouse button or click the a ico a pop-up menu will
provide you with the option to select a transition.

4 | Cut

[ Copy

D Rermove

(i3 | Paste

DObject zettings

i Captioh

«  Editimage
i Select transition |
—];\- Select test animatian
| Record sound

{? Set camera pan

?g Set movemnent path
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About the Object settings

Every object in a slideshow has a set of so called Object settings. For example, you can set the Duration,

specify a Transition and enter Text. Right now we only want to talk about the Transition. Here. you can find
more about Object settings.

Click on an image in the Image list or Timeline.

If you don't see Object settings in your current view you can open it by right-clicking on the image.
Alternatively you can reach the Object settings under View -> Controls.
@

The transition is set on the Image-tab in the Object settings.

Object Settings

|Object settings
| [ Show object

Duration: i_200.51 sec =

- |

Use default duration (Setkings)
eave in place after replay

| |I|TIE|EIE| =2 Trarl-_:l,_;lar'eru:';.-"
DO oL Yo S =
= File name [
Cil.:;l,l\'ied.ié'l,lmage-s'l,il.'ng_1.'53.0?;04.jpg @
[=] Transition

Randomtranstion - | | (@ adust |
= Background

Fil [Automatic on; - | @ =
Fill colar: E]
=/ Position

Aspeck ratio:

Alignment;

In the transition list you can see all pre-defined transitions and select one. Each transition is customizable after
clicking on Adjust.
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Encircle 3D x

Cruration of transition: ;SEIE TEC :-\

Rotate path: |186°_ -
Mirrar path: 'ﬁnﬁzaaa@ -

-

Duplicate: |2 # =

Attentior; More than on path requirez
conziderable processar power and could cause
jerking an a PC. DVDs and [SCDz will run

; Ok ;i | Cancel

(’“\\ If you want to change the transition for several images at once just select these image in the Image
list and set the desired Transition in the Object settings. It will be assigned to all selected
images.

Via Ctrl+A you can select all objects in the image list. With the held down Ctrl-key and mouse
clicks you can select seweral single images.

2.3 Text animations

Of course a slideshow should also have text, and it shouldn't be just simply displayed but it should be possible
to animate it.

In AquaSoft ® SlideShow you can enter text to an image or display it on a colored background. Texts also
can fly over the image along freely definable movement paths.

2.3.1 Texttoimages

In the Object settings of an image there is a Text -tab. The Object settings will be displayed when you select
an image in the Image list/Storyboard/Tim eline with a mouse-click.
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If you don't see Object settingsin your current view you can open it with a right-click on the image.
Alternatively you can reach the Object settings under View -> Controls.

==

|Object settings

| [ Show ohiject

-

Dt ation: ES,DD sec 2 | Distance: (0,00sec 2 |

™ Use default duration (Settings)
|¥] Leave in place after replay

— o T
| | T reut lw i Transpatency

= Font

[%] arial  AbCOEfGH] - ~ ]

|

[=] Skyle Alignment

AlAa =3

[l Text

W
L
I

[=] Effect

A iD S Border color: | -
Gl B
{Alphablending = | T Edit |

= Potation around text = Show ket with image
—center

Behavior along a movement path:
[Text block - |

Here you can enter text to an image and assign formatting like font, font size and font color.

The available formatting options are almost self-explanatory due to their icons, and you probably know them
already from word processing applications.

The Alignment has a small peculiarity, however.

[;] Positions the text at the lower edge of the screen.

% The text will be displayed in the center of the screen.

[ﬁ Positions the text at the upper edge of the screen.
Detaches the text to be able to customize its position.

The text will be displayed underneath the image. This also applies when the image is scaled smaller.

Enter the desired image caption into the text field. Specify font and font size. If you want colored text you can
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change the font color. Select the position of the text. If you want a customized text position click the -
button under Alignment. All changes are immediately visible in Layout Designer. In the customized position
the text gets its own position frame. This way you can freely place the text anywhere on the screen.

B B X | Object Settings = 0 x
ject settings

""" | @] show object

Duration; [5:00sec 3 |

| Use defaulk duration (Settings)
/| Leave in place after replay

| [Mustangs

=l Effect

il A (.,Q an 8§ Barder color: |»
Anirnation: i _
|#lphablending | e Tt
- Ratation argund text_ Show bext with image
= center -

Behavior along a movement path:
[Text block -

In AquaSoft ® SlideShow you can decide if you want the text to be separately animated or to be part of the
transition effect of the image it accompanies .

I=I Effect

A E'«»:' D E Border color: | | -
.F'.nimatil:un: _

‘Alphablending " e Taede o
__ Rotation around text —
s [ Shiowe bk wikh image
= =) z|| ] 30 LELEH

If you don't want a separate text animation please activate the option Show text with image.

For text that you want to be animated you can choose from a list of pre-defined animations. Click the Edit
button to adjust the settings for the animation. You can also see a preview of the animation in this dialog.
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Bnirnation: |Alphablending-changed . | [IEI

Fade F| Fade cut

Effect: igoom *

Duration: !E,_D_D sec 3
Characters I
simulkanzousky: L

Font width: 4\)— 100%

Font Height: A\J— 100%

Mumber of rotations: |0 B

Center of rokation: Icharacter center - l

[F Randorm order |#] Activate alphablending

|71 Movement |7 Ratate in direction of moveme

Example text:

IMustangs

& Modulation

|'} 0K i e JEancel oy

@ You can also open this dialog by clicking on an image in the Image listor Timeline and then on
l Select text anim ation.

Under Fade outyou can specify if you want the text to stay visible until the end of the image duration and to
be included into the transition to the next image or if the text fades out at the end of the image. The duration of
the animation specifies when the fade-out is to be started.

If you set 3 seconds then the fade-out starts 3 seconds before the end of the image display.

E]

By clicking the -button you can sawe the text effect settings you just selected. They will then be stored in
the Toolbox under Text effects and can be reused at any time. Saving text effects is only possible with
AquaSoft SlideShow Ultimate and Blue Net.

After you finished all the adjustments you can then replay the image together with the text by clicking on
Z]

You can find all pre-defined Text effects in the Toolbox as well. You can use these simply by Drag&Drop, i.e.
by dragging them with pressed mouse button to an image.

Select a Text effect and you will see a preview of it.
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Drive through (single, Drive through {single,
left ko right

Drrive in From right
right ta left)

Drunken rise
(centered)

Mote:the musictrack remair

As described above, you can enter and format text on the Text-tab in the Object settings.

2.3.2 Textwithoutan image

31

In the Toolbox under Slideshow objects there is the Colored background. With this you can fade in text
independently of images. The Colored background can even be faded in animated.

To insert it, double-click the Colored background or drag the object into the Image list or onto the Timeline

with the mouse button pressed down.

When inserting it with the mouse button pressed down, you can also determine the desired position

on the Timeline and in the Image list Should you wish to add the Colored background between

two images, drag the object to the desired place with the mouse. A red line will appear between the

two images. Release the mouse key to insert the object at this position. This is also possible in

the Image list.
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AquaSoft SlideShow - Help

w ohjects I
| & Default - |
% % 48 &) 1
Chapter Collage Image Particle Placeholder Sound Text Widen
: Colared Palse Play ‘White,
| & backaroun transparent -
& X
Tirnediree: d
lI 1' Z a q 2 a q La Lt () (4 i £ 13 (i) It )
Onin wmin
A H : -R.

ot the musictrac rems

The Colored background is shown on the Timeline as a black image. In the Image listit is listed as
black 1x1.gif.

The text can now be entered as with a normal image.

On the Timeline, click the object with the right mouse button and select Select text animation.

B0 D

Cut

Copy

Bermove

Paste

Object zeftings
Caption
Editirnage
Select branzition

Select text animatian jl

7 % ¥ B R

Set camera pan

Set movement path

Record sound
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Now the Select text animation window opens. There you can enter the desired text and select and edit a
corresponding animation.

Animation: [EEEEE T tam right, narrow) IEI

Fade in | Fade cut

Effect: igoom *

Duration: !2_,50 sec 3 |

Characters
simulkanzousky: i R, 41|

Font width: 4\)— 100%

Font Height: B 100%

Mumber of rotations: |1 B

Center of rotation: Iright -]

[~ Randam order |#] Activate alphablending

|| Movement: || Ratate in direction of moveme

[F] Consider letter position

Start position: |bottom tight b
3 |0 % = |
Example text:
e Iy sample texct

& Modulation

|'; 0K i |. ‘Cancel ||

Under Fade out you can determine whether the text should remain visible until the end of the image and should
be cross faded with the next image, or whether the text should be faded out prior to the end of the image. In
this respect, the duration of the animation determines when the fading out should begin.

Should you set 3 seconds, the fading out is started 3 seconds before the image finishes.

D
o
With OK your entries are accepted and you can use to play back the text animation on the screen.

The background is now shown in black. If you wish to have a different color, you can do this in the Object
settings of the Colored background. For that purpose, you hawe to click the object in the Image list or on
the Timeline. Should the Object settings not be shown in the view available to you, you can also retrieve them
by right-clicking the object.
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Object Settings = A |

|Dbject settings
[#! Shoiw object
Duration: |200.51 sec :_|

7] Use default duration {Settings)
¥ Leave in place after replay

o . A R 2
=l File name
01\ MedialImages\img_1930704 jpg B

[=] Transition

iRandnm transitian - | |-. Adjust 'l
= Background

Fil Automatic (o - | @ |
Fill calor: E

(= Position

Aspect ratio: keep - |
alignment: |_: Center % |

|7 | Rotate in direction of movement

1

By clicking the selected button you can change the background color.

You can also have the colored background faded in animated. Under Transitions you can select a cross fading
effect.

Under Textyou can carry out the formatting of the text, as well as change the color of the font.
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Object Settings

|Object settings
| [#5how object

Duration: ,10,_00 ser ,

I Use default duration (Setkings)
|¥| Leave'in place after replay

i» Transparency '
=/ Font

[4] aridl  ebcoEfohi w 1~ [ ||+

= S_lt__yle Alignmeng

AA =EB=_-=—F
[=} Text
[= Effect

A ?ID S Border color: | -
Animation; S
i.ﬂ.lphablending - |: ’];-_\- Edit |
- Ratation around bext |-,  Shaw ket with ii'nagel
—center -

-

Should the text not be faded in animated, but together with the colored background, check the Show text with
image option.

P

The Colored background can also be used to dim out/fade out images. Should a black
background color be set and a cross fading effect selected, it has the effect on the observer of a
fading out of the previous image. In this way you can end a slideshow in style.

2.3.3 Rotating text

Adding texts to images or a colored background has been described in previous chapters. This chapter is
about their rotation functionality.

@ This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

@

First add a text to an image. This should look similar to the following graphic in Layout Designer.
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loyoutesiore o x|
B O O | I (Rl | 08 05 | B | Timeimarke 0 sec 2 ||/

ii_;-i'li_.-:iiﬂ'w o o o

Please note the green handle above the text. You can use it to rotate the text. Click the handle, hold down
the mouse button and move the mouse in a rotating motion.

# '-%':_'{'\:@E@Q ":%%::Timgmark:iﬂ\sic :'Eq

| — | _T-,- P
R R R R

The number next to the green handle shows by how many degrees the text has been rotated.

You can find more information about the use of rotated text in chapter Letting texts fly.

2.3.4 Multiple texts

In AquaSoft ® SlideShow there is also the possibility of fading in multiple texts either simultaneously or with
a time delay.

In the Toolbox there is the text object for this purpose.
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Slideshow objects

| = Default

Chapter Collage Image
Teit Wideo Colored
background

el 18

Particle  Placeholder  Sound

=6 >E

1nthite,
transparznt

Pause Play

Fading in multiple texts, in sequence

In this example 3 texts to an image appear, in sequence. The number of possible texts is not limited.

Insert an image. Using the Toolbox, now add 3 Text objects. You can do this with a double-click or by means

of drag-and-drop (dragging with the mouse) into the Image list or onto the Timeline.

Irnagelisk

| Dbiject
0 1img_193070... 0,0 sec
b T 2, Text 1 5,0 sec
v T 3. Textz 10,0 sec
fue [ T 4 Text3 15,0 sec

Starttime Duration |
5,0 sec
5,0 sec
5,0 sec
5,0 sec

37

Now select the first Text object. In that respect, it does not matter whether you click it in the Image list or on

the Timeline.

In the Object settings of the Text object, you can now enter your desired text and carry out the formatting.
Position the text in the Layout Designer.

@2 O |

=& x|
2 E%B&;:Timgmark: nzec 2 IE
[] Show object
Curation: !5.00 s6C :_|
¥} Use default duration {Settings
|¥|Leave in place after replay
T Textl @ Transparency
(= Font
Arial ABCAENGH] - - (-
= Style Alignment
A =EE=E—==E
= Text
Text 1
||| = Effect
A in S Border colar;
Animation;
chastic burn in - | Ir T it ,I
= Potation around text
= cenier
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Select an animation and then call the editing function of the text effect via Edit.

So that the text is not faded out again before the next text is shown, the No fade out option must be set
under Fade out.

Bnirnation: |Chaotic turnin - | |@|

| Fadein | Fade out

Effect: iNo Animation *

Example text:

Iy, aguasoft, net

|'} 0K i e JEancel oy

You can also hawe the text faded out if it is no longer supposed to be visible when the subsequent text is
displayed.

Now repeat the steps with the second and third Text object.

|Q>‘:4, ':%'@.%"’ EEDEEH Time rriarki |0 sec - =

T R I I

Then play back the little show with
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In the Object settings of the Text objects you can change the holding time of the texts.

Object Settings

Duration:

¥ Leave

Object settings
[} Shoi

[#] Use deFault duration (Settings)
‘in place after replay

object

i_5_,DD SEC ‘_|

-

[4] arial  AbCeEfGhi v 26 - [

Animation:

= Style Alignment
Ba EB==-=—E
= Text
Text 1
= Effect

A 3D S Border colar; E

|Chaotic turnin T | ¢ T edic 1|

[l center

_ Raotation around text

Behavior slori & moyverent path:

| Taxt block

-

Showing multiple texts simultaneously

In order to now not show the texts in sequence, but simultaneously, the Chapter object is required. Use the
little show that you hawe just created.

| 2 Default
(|
" n L
B [ 1&)
Chapter Collage Image Particle  Placeholder  Sound
Teit Wideo Colared Pause Play \hite,
i background transparent -

Add the Chapter object into your show.
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E
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I L 5. Chapter 43

Click on the image on the Timeline and drag it with the mouse button pressed down to the Chapter object.
The Chapter is framed in red if you go ower it with the mouse. If this red frame appears, "drop" the image.

After that it looks like this on the Timeline. You now have to open the Chapter. There is a little plus symbol
for that.

Now drag the first Text object into the Chapter. Drag it to underneath the image in the Chapter. A red vertical
bar will appear if you move the mouse to the correct position.
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Now drag the first Text object into the Chapter. Drag it to underneath the image in the Chapter.

If you now drag the Timeline to make it larger, it must look like in the illustration.

Now play back the show again with —I . You will see that the image and the texts are all faded in
simultaneously.

Using the Timeline you can adapt the timing individually. For this, you can simply drag the Text objects with
the mouse into the starting position.

When you don't work on a chapter you can close it by clicking the minus symbol.

2.3.5 Letting texts fly

The Text objects which you have already become acquainted with in the previous section can also be animated
with a movement path. In other words, they can "fly" across the image.

For this purpose, the Layout Designer provides the necessary tools.

Insert an Image and a Text object into your show.
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| Object Start time Duration |
oo W @ 1,img_193070.,, 0,0sec  5,0sec
e W T2, Text 1 5,0sec  5,0sec

Then click the Textin the Image list or on the Timeline. In the Layout Designer the tools for the movement

path are now enabled.

Layout Designer

TS T S R I%.—,:-" I =t | Timefratk: 0sec 2| [H

lﬂ

Tirne marks | 2.5 sec o ||

[

This is the icon for switching, in the Layout Designer, into the mode for movement
paths. There is yet another mode for camera pans and zoom. Since this function
is not available with the Text object, the icon for the movement path mode is
active.

Use this button to insert new movement marks. The course of the movement is
established on the basis of these marks.

In order to remove movement marks that have been set, the latter must be
selected in the Layout Designer and can then be removed with this button.

In this respect, an additional menu for the movement marksis opened. This is
explained more precisely later on.

The chronological course of a path is established with timestamps. They thereby
determine how quickly the sequence should occur. That is clarified in an example
below.

Newly created movement paths can be saved using this button and later
conweniently reused. This function is only available in SlideShow Ultimate and
Blue Net.
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Inserting a movement mark

ia_;—.i]i_.-:iih fool e

Insert a movement mark by clicking

Positioning a movement mark

ia_;—.i]i_.-:iih fool e

You can now drag the movement mark inserted in the Layout Designer. For that purpose you have to click
in the text area and then drag the latter with the mouse button pressed down.

The orange dot shows you which movement mark has been selected.
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Ed
Now you can replay the show by clicking and watch how the text mowes.

Chronological sequence

Layout Designer = ox

0 3 0| | B % B [rimarmosa:0c ]

ia_g-iFiin |

With Time mark you can control the sequence. If you increase the time, the sequence becomes slower. If
you reduce the time, the sequence becomes faster.

First increase the Time mark of the movement point and then replay the show.

Starting time

i_ayuut Designer =] '.1 b4
P : i -i@f e i : ' Time rratk: |2 sec :I
=== l ————— ]
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If the movement sequence is only supposed to begin after a time delay, you can increase the Time mark
with the first movement mark. For that purpose, click the movement mark and then increase the time unit.
The subsequent movement marks will automatically be adapted.

Inserting additional movement marks

You can insert as many Movement marks as you like. The new movement mark is always inserted after
the previously selected mark.

:ll.lx

&
Select the last movement mark and with —l insert a new mark and position it in the Layout Designer.

Play back the show. You will find that the last part of the movement path elapses faster than the first part.
You can control this for the 3rd movement mark via the Time mark.

Hard and soft curves

In the course of movement you can choose between hard and soft curves. With Hard curves the path will run
exactly in accordance with the movement marks. With Soft curves a round course of movement will take
place. You can use both cune types within one path.
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®
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o ]

Add movement mark

Delete mowvement rmarkis)

Copy path

Position frame k

Curve type 3

Transform path

Custorm entry.,

Select all marks

Select a movement mark. Using the right mouse button you will get the menu for this movement mark and

can change the Curve type there.

Change the Curve type for all 3 marks.

l”ﬁq,:;}-fﬁ:@:fgﬁ\-

el o

You will see that the movement marks now have a rectangular marking point. Selecting Soft curves these

points become round.

In order to see the change in the path, play back the show.

Rotating text during movement sequence

In SlideShow Ultimate and Blue Net you can rotate or swing texts during a movements sequence also.

For this purpose there is a green handle abowe the Text field. More extensive information about the rotation
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functionality for Text you can find here.

ii_y-i'l'l_.-:ii""" b ol e

First rotate the text at the first and second movement marks. Rotations through 360 degrees are also possible,
to create complete rotation.

® (':'&: rs\‘,\:@.i.@af' %E&E: Time mark: ELJ'@

Play back the show. You will see that the rotation center is, in this respect, the midpoint of the text box.
Should the rotation center be the center of the text, enable the Rotation around text center function in the
Text properties.
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arial  AbCHEGH
= Style

| =l Text

i-Texlz 1
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Alignment
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| =l Effect

- A-‘iﬂ' 5 Border color: | |-

Arirnation:

| |Chaotic tumn in L e

- Rotation around text
M center

Behavior of text along a movement path

There is another option for text moving along a path.

frisl  ALCOETGH

- =k
[£=1 Style Alignment
AA B==-==E
| =l Texk
Test 1
| =l Effect

%

. A-‘iﬂ' 5 Border color: | |-

Arirnation:

IChantic turr in - | |

— Rotation around text
M center

| |Behawior along a movernent path:
{Text block |

| T Eitcomnd

according to the path direction.

Use it to let text "snuggle up" to the path as text block or even character by character. The text will rotate

Letting the text fly in from

outside

There are two areas in the Layout Designer. Firstly the visible area, and then the invisible area.
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oosvesgrer = x]
(W W S e 1%&-@9‘-‘ U | T Timerare[0sec 2 ||
invisible area

visible area

b T

+ | Enlarges the visible area in the Layout Designer.
* | Reduces the visible area in the Layout Designer.

"% | Restores the normal view/window size.

{=h
Continue to use the show you just created. Reduce the \isible area with in order to see the invisible area
in the Layout Designer.
oo i ]

e |l bl
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Now select the first movement mark and drag it into the invisible area.

T ——3
':*_'}) i% 'f%:@l%lﬁ,ﬁ' %D&E: Timg-mark‘:ésec ::@
-2t ‘q

S T A T

Play back the show. The Text will now fly into the picture from the outside.

Zoom function for text
Just like rotation, this function is only available in SlideShow Ultimate and Blue Net.

Trawveling along a movement path Text can increase and decrease in size. The smallest size is defined by its
specified font size.

Select the 2nd movement mark and increase the size of the pasition fram e of the Text-field.

i_ayclut Designer =0 ox I
By 'T%:@:i%jn,g" e Ft P Rl Time rarke [6sec - || (5
L ’Q

[ T R e

Play back the show. The Text will now fly into the picture from the outside.
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Further options

Via

the context menu for the movement marks can be opened. With a right-click on a selected

movement mark, this menu can likewise be opened.

oo —
M TS Wl B R B :?B@Ei'i?' | = |
r-2on ’Q

R 1 T L R L |

m Add movement mark
u@; Delete moverment mark(s)

Copy path

Curve type 3
Transform path 3
Custaorn entrey..,

Select all marks

Some options have already been used abowe. The following further options are available:

Copy path

Inzert path

Paostion frame

Curve type

Transform path

| '[.’-"- Custorm entry...

| B | Selectall rmarks

Manually editing the path

A movement path already created can be copied and thus re-used
with a slideshow object. If you copy a movement path from a text
object, this can also be inserted in the case of an image.

With this option, you re-insert a copied path from the clipboard.

If you want to be sure that the text or the image does not change size
in the course of your movement path, you can set the Use the size
from the previous one option here.

There are hard and soft curves with a movement path. The course of a
movement can thereby be modified.

A movement path can also be mirrored or rotated. You will find the
available options under this point.

A movement path can also be mirrored or rotated. You will find the
available options under this point.

With this all movement marks can be selected. Thereatfter it is
possible to drag the movement path as a whole.

Manually entering the path enables the movement points to be positioned exactly.
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Layout Designer - Custom entry X

[Mark 3 - .00 sec - | :

% 184 Width: R
¥ 762 [T Height: 10 [
Tirne:; 8.00 sec @ !Freely adjustable i |

" Rokatior:

angle: 0.0°

Left: 54 Right: e [0
Top: £72 Eiottom: sz (%)

Curye bvpe: !Smooth Curve

|| Relative input || High accuracy

The Layout Designer is specified with a size of 1000x1000. The center of the image is therefore 500x500. Here

you can directly specify the positions and sizes. You can also change between the individual markers in this
window.

2.4  Multiple tracks

In AquaSoft ® SlideShow at first glance you only see an image and music track on the Timeline. This
senes to provide a better oveniew. At positions where you require multiple tracks, the Chapter object is used.

With this you can connect as many tracks as you want. In that respect, it is not predetermined which objects
can contain a track. Therefore you can place images, music or texts on any track.

You will find the Chapter object in the Toolbox under Slideshow objects.

| = Default . I
v |
) A % =
e & 3?4** [1&)
: Chapter Caollage Image Particle  Placeholder  Sound
—~
TERH > &
! )
Text Videa Calared Pauze Play WWhite,
background transparent -

The Chapter can be inserted by double-clicking. You can, however, also drag it to the desired position on the
Timeline or in the Image list with the mouse button pressed down.

Insert a few images and a Chapter into an empty show.

The Chapter is inserted as an empty container. You will then have to move the desired objects into the
chapter. You can do that on the Timeline or in the Image list or Storyboard. Click on an image and then drag
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it with the mouse button pressed down to the Chapter.

If you go over the Chapter with the mouse, the Chapter is framed in red on the Timeline. Let go of the image
there.

This shows that the objects are to be found in this Chapter. By clicking the Plusicon you can open the
Chapter.

Timeling

Underneath the Image object a hint regarding a new track is displayed. To add an image to the second track
you need to mowe it to this track.

The red bar under the first image determines the starting position of the image. The image is inserted at this
point.
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The reference to a new track now appears under the second image. You can place as many objects as you
wish on each track. In that respect, the red bar helps you to insert the objects in the correct position.

You can also insert Slideshow objects into a Chapter directly from the Toolbox. First of all drag a Text
object onto a new track.
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e el Transibions | Image effects

| = Default |

e e 1T

Chapter Collage Image Particle Placeholder Sound Text Wideo

Colored Pause Plav ‘White,
background transparent

IElirE

* Mote: the musictrack remains

Timeling

=R Storvboatd
SN -

You can change the positions within the Chapter by dragging the objects with the mouse. By clicking dragging
the beginning and the end of an object, the Exposure time/Holding tim e of an object can be changed.
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on the lowest track is arranged on top of the other objects. In this example, the text is shown on all 3

@ The objects within a chapter behaviour in a similar way to a pack of cards. In other words, the object
images. Should the text stand on the first track, it would be covered up by the images.

Example:

Often we are asked how Track/Sound is set for only a few images. The Background music should be faded
out at this point, but not interrupted.

Insert a few images into an empty show and a Chapter.

Timeling

U= R Storybostd

Now drag a Sound object from the Toolbox onto the 2nd track in the Chapter in exactly the same way as the
Text object was inserted into the Chapter above.
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57

You can add Background music by clicking the corresponding track in the Timeline. Using the Plusicon,

you can insert the track.
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The title is then shown on the Background music track of the Timeline.

The Object settings of the Sound object should be displayed in the Object settings window. If not, select the
Sound object on the Timeline by clicking it with the mouse.

Should the playback length of the sounds be too long for you, you can reduce it. The relevant settings are
marked in red in the illustration below.
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OChject Settings =R X
Object settings
[¥] Show object

[ouration: 25,00 s=c |

™ Use default duration {Settim's';l

uffl Sound l

= Sound
nMediadMusiclartistl 01 -Title01  wma @
If & Record: 'J Duration: 03:19.904 @
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Volume; il_DD o %

|¥| Fade background music (Settings) -
= Replay behavior

Start position; @I

(7 Adjust display duration o sound duration
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I 20 Fade sound after set duration I
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On the Timeline you will now see that the Sound fits in with the 5 images exactly. The Background music is

canceled during this period of time. If you insert yet more images behind the chapter, you will see how the
background music track is continued.

Images, texts and sounds can be combined in a chapter as desired.
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The Chapter has a Minusicon at the top on the left if it is open. You can close it by that means if you are no
longer working on this chapter. That increases the clarity in a substantial show.

By utilizing SlideShow-Manager you can create a menu for your show where you can jump to these
chapters directly. SlideShow-Manager is already included in SlideShow Ultimate and Blue Net.
You can also add it as plug-in to SlideShow Premium.

2.5 Ken Burns Effect

You will find an example of the Ken Burns effect in the sample slideshows supplied with the software.

In AquaSoft ® SlideShow you can quite simply apply this effect to your images.

Insert a few images into an empty slideshow. In the Toolbox you will find the Ken Burns effect under
Movement paths.
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If you would like to assign a Ken Burns effect to several or all images select these images.

All images = Ctrl + A

Certain images = Ctrl + right click on the image

61
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Select the Ken Burns effect with the left mouse key, then click right and select Apply. The Ken Burns effect

will be assigned to all selected images.
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Now select Alphablending as Transition in the Image Object settings. The Fill function has to be enabled

as well.

Object Settings
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Then play back the show with

63

You notice that the transitions could be a little smoother. This can be accomplished by using a Chapter. Add
a Chapter to the show. Mowe the Images into the Chapter and arrange the images in a stair shape. The start
of an image needs to be mowed slightly underneath the end of the previous one.

Then play back the show with

The Ken Burns effect is implemented by means of a Camera pan. You can also change this individually. For

that purpose, you have to change in the Layout Designer to the Camera pan mode. To do that, click

the Layout Designer.
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The movement path is now shown in the Layout Designer. How quickly or slowly a movement progresses is
determined by means of the time set to the 2nd movement mark. The greater the time, the more slowly the
movement is carried out.

In order to change the time and thus the sequence, click the 2nd movement mark in the Layout Designer. The
movement mark with 0.0 sec is the first one and therefore the starting position. After you selected the 2nd
mark you can change the time set via the image under Time mark. A selected movement mark is shown in
the Layout Designerin orange.

When using a Ken Burns Effect only a part of the image section is used at the first movement mark. You will
notice the smaller Position frame. Only during the Cam era pan will the full image section become visible.

Therefore, the Position fram e is larger at the second movement mark.

You will find more about movement path in the chapters Movements and Zoom.

2.6 Adding videos

You can not only use images in AquaSoft ® SlideShow, but you can also insert videos.

To insert a video, you will find the the Video object in the Toolbox under Slideshow objects.

Slideshow objects BEEEE
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e o[ 18
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>

Play

el »

Sound

Inhite,
transparent -

You can insert it with a double-click or drag the Video object with the mouse out of the Toolbox onto the
Timeline or Storyboard or into the Image list.

In the Object settings of the video you now have various setting options. Should the Object settings not be
shown in the view available to you, you can retrieve them by right-clicking the video on the Timeline or in the

Image list.
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Should the full length of the video not be played back, remove the check mark beside Play back the full
length of the video. You can then determine the playback duration individually.

You can crop the video at the beginning using Start time. If you don't want to play the video from the very
beginning enter the point of time where you want the video to start. Under Duration specify its playing time.
This way you select the part of the video to be played.

Should the video not be intended to be played back full screen size, it can be freely positioned in the Layout
Designer. You can also assign a cross fading effect to the video.

The Fill background function enables you to see the previous image during playback of the video or cover it up
with a colored background.

Under Sound you can determine whether the background music is supposed to be faded out during the course
of the video being played. Should you have your own audio or spoken commentaries in the video, you should
use this function.

Further Object settings of the video are explained here.

The video can also be animated with a movement path. How that functions exactly you can find out here.

Technical information:

Prerequisite for playing videos is a suitable DirectShow filter. In many cases it already exists on current
Windows systems.

SlideShow 7 Blue Net comes with its own DirectShow filters for a variety of video formats (AC3, H.264, MKV,
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MOV, MPEG1, MPEG2, MP4, MTS, M2TS, Qt, TS, WebM).

If your video can not be played in SlideShow, it could be due to a lack of DirectShow filters for the video format.
Partly they can be installed later. There are different codec and filter packs available for download. Please refer
to the notes to the codec package and also visit the website of the provider of this package. The installation of
codecs can also affect other programs.

Please \isit our FAQ (http://fag.aquasoft.de/index.php?action=artikel&cat=15&id=22&artlang=de) for detailed
information.

2.7 Collage

In only a few steps, you can create beautiful collages.

Double-click the Collage object from the Toolbox.

'.I-'|:||'||t||:|::-:: = X l

N slideshiow objects BEE
| & Default - [l
oRe 18
Chapter Caollage Image Particle  Placeholder  Sound
| I
Teit Wideo Colared Pauze Play Inlhite,
background transparent -

In this way a Collage is inserted into your slideshow. Click this Collage in the Image list or on the Timeline
and you will see in the Layout Designer that the Collage is empty at the moment. In order to fill it in, just
double-click the Image object from the Toolbox.

e.

Image

In the dialog which now appears, simply select all images to be used for your Collage.

These are inserted into the Collage, since they were selected in the Image list and on the Timeline. If you
click ® next to the Collage, you can view all images in the Collage.
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Now simply click on the individual images and drag/maximize/minimize them as you please, until you are
happy with the result. You can reduce the images using the positioning framework in the Layout Designer.

CWCY @ﬁ;@:iiﬂiﬂf.‘@i@;@{:Timg.mam-. Dsec = |[WED
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Ls-i'u_;iiﬂﬂ b o

Now insert a Text from the Toolbox and position it as you please.

T

Text
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If the Textis not inserted into the Collage now, the Collage was probably not selected when you
inserted the Text. Click and simply drag the Text onto the Collage and release the mouse button.
This works in the Image list, on the Timeline and on the Storyboard.

:

P ':fﬁ:@l%—,:" |%'@§,: Timg-mark‘:'ﬂsec :l:@

S T Py

Now you have a finished Collage, consisting of your images and a text. The images can also owverlap. Likewise
you can create an image within image effect by not reducing the size of the first image.

If you select the Collage object, you can change Object settings of the collage. You can determine a
transition and change the exposure time.
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Object Settings
|Object settings

| [ Show ohiject
Duration: EE,_DD sec :|

[¥] Use default duration {Settings)
[¥] Leave in place after replay

I|Image| " Transparency

DO oL r =

=l Title

| 3

[=} Transition

E.Ranul:iui'nm transition | | (5l adjust | E
=l Background
Fill |Automatic (on; ~ | @

Fill calor:

[=! Pasition

Aspeck ratio: Ekeep - | I

Alignment: | Center T

7| Rotate in direction of movement

Images and texts within a Collage are not independently animated. To achieve this you need the Chapter
object.
As you can see, putting together a pretty Collage is achieved quickly and easily.

¢/~ Asinanimage, ina Collage you can zoom and furnish this with a camera pan. Simply try it out.
\ You will find more about movement path in the chapters Movements and Zoom.

2.8 Movement paths
You already learned about movement paths in chapter Text animations.

You can apply movement paths to the following Slideshow objects:

T 4%

Image Text Particle Collage Yideo

Insert an image which you would like to animate with a movement path.
Then click on the image in the Image list or on the Timeline. In the Layout Designer the tools for the
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movement path are now activated.

|| T Pl e 2 B s 052 - ||

This is the icon for switching into the mode for movement paths in Layout

qﬁ'_pl Designer.

‘gﬂ Using this icon, switch into the mode for cam era pans and zoom.

ok Use this button to insert new movement marks. The course of the movement is
_I established on the basis of these points.

o) To remove movement marks that have been set, the latter must be selected in
_I the Layout Designer and can then be removed with this button.

You can use this to open a further menu for the movement marks.

o ~ The chronological course of a path is established with timestamps. You can
Tirne mark: |25 sec || thereby determine how quickly the sequence should occur. That is clarified in an
. “  example below.

= You custom movement paths can be saved and reused. This function is only
= available in SlideShow Ultimate and Blue Net.

2.8.1 Simple movement shots

Your images learn to walk. With a few clicks your images wander over the screen. Simply follow these
instructions and you will be quickly and comfortably introduced to the colorful, moving world of AquaSoft ®

SlideShow.
—‘ and insert an image.

Create a new slideshow
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Image

Click on the image in the Image list or on the Timeline, so that the image is displayed in the Layout
Designer.

O O el | B B | Tt 52|

T S B L R |

In this example we would like to explain how you can arrange for an image to fly onto the screen from outside.

For that purpose, we have to enlarge the invisible area with

lpsiosne o+ x]
@ O O | 7 (Rt 8 T | | Timemarke[05ec 2 ||

[ S R
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Now move the image into the invisible area.

| ':;‘ﬁ i;& I.':_QJ_ | @ %4& | % Da; | | Time rrark: 0 sec :l B

R T R R

ks
Now insert a new movement mark with —I
area.

< TS Wl S e “gﬂ{g' D@g, T | Timenatk: | 2 zec :l =

e e (=] ———

[ [ R bt B R |

. Then mowe the newly inserted movement mark into the \visible

Play back the show. You will see that the image now "flies onto" the screen from the top left-hand corner.
Increase the timestamp at the 2nd movement mark and movement becomes slower.

In order to be sure that the image arrives in the center of the screen and also the size of the image is not

]

changed, retrieve the Custom entry once via
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Layout Designer - Custom entry X

frark 2 - 4,00 sec| g =

% so0 [Ty | width: (1000 *,,
¥ si0 (%) | Height: (1000 *,,

Tirne; 4.00 sec @

" Rotation:
angle: 0.o-

Left: i 24 Right: oo (%]
Iopi [0 4 Eattom: Tz
Curve typs: |smonth curve - |
|| Relative input [ | High accuracy

Select Mark 2 and enter 500/500 in the center Also set the Size of previous item. so that the size of the
image is not accidentally altered during the path.

The Custom entry assumes a system of co-ordinates in which the Layout Designer is 1000x1000 units wide.
Therefore, in order to center our image, enter 500 at X (the horizontal position of the midpoint) and at Y (the
vertical position of the midpoint), i.e. half of the respective total extent. You can also use negative numbers.
These then refer to the invisible area.

2.8.2 Movements with alterations in size

In the previous example there was no change in the size of the image along the movement path. Now we would
like to show you how to change the image size in the process. This way images can grow or shrink.

Images grow
The image with the path set from the previous section also has to be modified slightly.

You should see it like this in the Layout Designer:
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@By By |
e
1 G)J.I.U-:-‘:c.

-
A 8 e

I_svﬁmuﬂ ol e

| |
Now open Custom entry using the icon.

Select the 2nd mark and change the setting under Size to Freely adjustable.

Layout Designer - Custom entry

IMarkZ -4.00 secl

Center;
S0 (B widkh:
S0 [fg)  Height:
4,00 sec . Freely adjustahlz

‘Rotation;

Left: F Right: 1000

Taip: £7|  Eottom: 1000

Curye bvpe: |5mooth CUrveE

|| Relative input [ | High accuracy

Then close Custom entry. It is possible to also carry out the next step from this menu, however we are
choosing the Layout Designer directly.

Using the positioning framework, reduce the image at the first mark, i.e. the mark which is outside the visible
area. Then move the mark closer to the \isible area.
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Layout Designer =R I

O-- O -4
0 Qoo
| -~
o--o--%8_
T
-
S
T

I_s-i]:ﬂh (R |

Now play back the show and you will see that the image is larger when it is in motion.
You can select a Transition, or also None, in the Object settings of the image.

First of all, position the first mark in the \isible area. Then restore the Layout Designer to Normal view using

¥

Then access Custom entry.

Layout Designer =55 x|

i, 170 wwiidkh; 50
iu

170 Height: 250

13,00 sec I ||'-': paly adjustable b |

Right:

Botkom:

Curve bype: |Smooth curve - |

[F Relative input [El High accuracy

First of all set the values shown in the image. In the Object settings of the image select a Transition.
Afterwards play back the effect.

Now the image should fly back to its original position. For this, two additional movement marks are required.
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Click the 2nd mark in the Layout Designer and then insert an additional movement mark with

Layout Desigrer =0 I

@ @ O | [ o) | % | B | Timemarta 3502 || (]

B
n
]
,Ih—._—"-‘.

Lo i | o e}

This mark is required to allow the image to stand still. The image should not become smaller again
immediately. In this case a movement mark can be directly laid over a previous mark. To do that, you only have
to drag Mark 3 owver the top of Mark 2 now.

Layout Designer =5 5 x|

Q%Q|@!i?‘%ﬂ§-éﬁi%%|!Tima.m_ark:|Eq
JEEE N NN e

Then increase the time at the 3rd mark, as given in the image above. Then insert a 4th mark with —I . You

will not recognize this immediately, since it is inserted exactly over the top of the 2nd and 3rd marks.

.

Retrieve Custom entry using
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Layout Designer - Custom entry

frark 4 - 13,00 sec |

i 170 wridth: 250 4]
i: 170 %] Height: 250 4]
Timne: 13-00'53:@ !Freely adjustable = |

left: 95 (%] mioht 25 &)
Top: 45 Eottom: 25 [T
Curyve type: |Smcn:-th Curve = |
| Relative input || High accuracy

Now, under Center and Size set the values which have already been used at the first mark.

If you now play back the show, you will see that the image is enlarged and then reverts to its original place.

Now insert a new image into the show. Click on our image above once more and access the context menu

using —I . There select Copy path. Now mark the newly inserted image and access the context menu

again using and this time select Insert path.

In the Object settings of the 2nd image you have to disable the Fill background function.

ERER [ o |

Y-
%ElFiIename

OiMedia\Imageslimg_1930704,ipg

| =l Transition

ERandnm transition - | |. Adjust '|
| = Background
[ Fil: o - |®
Fill color: @
' [=! Position
Aspeck ratio: IKeep - |
Aligrirment: | /= Center ¥ |

I |Rotate in direction of mavement

m

4

Now we will for once change the positions of the first and last marks. To do that, access the context menu
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Mark 1:

using and accept the settings below once.

Layout Designer - Custom entry

IMark 1-3.,00 secl

‘Center’
Width:
Height:

|Frr:-'.=iv adjustahle

Rotation;

Left: ‘Right:

Top: Boktorin:

Curye bvpe: |Sm00th Curve

|| Relakive input [~ | High accuracy

Mark 4:

Layout Designer - Custom entry

{mark 4 - 13,00 sef

tidth: =0 [

Height: 25

Tirne; 13.DD'sec |F.‘r:—!_=i\' adilstahle 2 |

‘Right:

Eattom:

Curye bvpe: |Sm00th Curve

|| Relative input [ | High accuracy

Then play back the show once in its entirety. And how do you like the effect?

In SlideShow Ultimate and Blue Net you can use Rotations. This is easy to accomplish via Custom entry,

too.
Open the context menu for an image via and select the 2nd movement mark. Under Rotation set the
angle to 360 degrees. Do the same with the 3rd movement mark.
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Layout Designer - Custom entry Layout Designer - Custom entry

IMark2 -7.00 secl

Width: 1w [ty ; S0 [Bg) | Widkh: 1w (5
Height: won 7] : 500 Height: w00 [ty

lFreer adjustable - | Tirne:; .00 lFreer adjustable - |

angle: 360,07 1.0 Turns right angle: 360,07 1.0 Turns right

left: O Right; o [f) left: O Right; o [f)
Top: 0 Eiottom: w5 Top: 0 Eiottom: w5
Curye bype: |Smooth curve - | Curye bype: |Smooth curve - |
|| Relative input [ | High accuracy || Relative input [ | High accuracy

Play back the show.
These movement paths can be used on the following Slideshow objects:

e TR =

Image Text Collage Wideo

2.8.3 Movement paths with rotations

Movement paths with automatic rotations can be applied to the following Slideshow objects:

¢ &=

Image Collage Yideo

Images, Collages and Videos can now be rotated automatically directly at the movement path. This way it is
possible to correctly rotate cars or planes according to the direction of their path.

@ This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

o

You can activate this option in the Object settings.
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Layout Designer

O 2 O i B | B | | Timemas 205ec 2|\ [
O 0
s g-=o=-g
a@@E- - — — — — — ofdn. o
0--0-0 o--0-0a P=g-4
o GI': rrﬁ—
Q--0--4 m--u-”—@"ﬁ'ﬂ
0 é:-{'g%?‘ﬁ"‘* ______ —Ellvi %@Uﬁ:c
1" é--ﬂ--é l‘j-.ﬂ._[l—l
l}-&'ﬂ
[ - |
o e
: .,_1 " o
o-o-0
Sy Ree=B=3]
o - - — — — - & S0sid: O
o---o O--0- g o
= .. [=E SR Riln
0 o ¢ gﬁ?‘
G--0--0 g--o-§-0-0
MR- - - - LEOHL
0--0-0 O-o-0
T R R T

= x| Object Settings
Object settings

:lux'

[¥] Show object

Duration: iZU-DU seC L | Distarice; |U.IIID sec |

[T Lse default duration (Settings)
|¥] Leave in place after replay

o NGO .

1= File name

ix. Tramsparency

1 Sound

s

DatahéutoDraufsichtGelb. png

= Transition

|N°“'3 '| o Ad‘just ,l =
= Background

Fill: IOH—,| @

Fill colar:
= Position N
Aspect ratio: Keep -
Alignment: I' Center - |

[¥! Ratate in direction of movement

Click the J icon and then Select all marks. You can see that the the car gets automatically rotated along

the path.

2.8.4 Text with movement paths

Just like images, you can also let text move along movement paths. Please read the chapter Simple movement

shots first to get to know how to set movement marks.

Create a new slideshow —J and insert a Text object.

T

Texk
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&

Now use to add several new movement marks. Position them in Layout Designer.

If you replay this small example you will see that the text moves along the path.

In the Object settings for Text exists an option to specify the behavior of the text along the path during replay.

I’ This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

i
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| T Text

— Font

(1] arial  spceEfoh) - 3w (-]

= Style Alignment
A =@=|-==E

-l Texk

|Text with overnent path

D S Border color: |- v|

Animation;
|Delete text effect - | T"\f Edit

- Rotation around text
‘center

Behawior along 4 mavement path:

Text blnclk -
Text block The text remains horizontally and moves along the path.
Separate characters The characters are separately animated and snuggle up to the path.
Rotate text block The whole text gets rotated along the path.
Rotate characters The characters mowve separately along the path and snuggle up to it.

Example: Rotate characters

m
4

ii E Current time;  00:11,208
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2.8.5 Camerapans

Create a new slideshow —J and insert an image.
Image

Click on it in the Image list or on the Timeline, so that the image is shown in the Layout Designer and the
corresponding tools are enabled.

O OO | | B B || Timemarte 05ec ]|

[T R T !

With camera pans the images must be enlarged beyond the \isible area. For that purpose, reduce the display
of the \isible area with the icon.
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e —
Al i 'I%-“S’? : o 'ﬁ;; | Time matk: (0 sec s Ve

O TR gy i

Now enlarge the image using the positioning fram e until it looks similar to the image below.

T —————————
TS T S R I|%=§? I i '@5; | Time rriaek: |0 sec =]
9]

e Ty i

T
Then, with the —,

, insert a new movement mark and position it to the left of the first movement mark.
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PUCA ; i |I%Ig§? : o 'EE,; . | Time matk: 2 sec s Ve
Q0

d==-=-=-===-==[j=-========L1

O TR gy i

Increase the time at the second movement marker, so that the movement is carried out more slowly. Should
you not wish to have any Transition at the beginning of the movement path, you can set None in the Object
settings of the image.

Then, with the right mouse button, retrieve the context menu at the 2nd movement mark marked. Now, in the
latter, select Position frame/Use size of previous item. As a result, the size of the second movement mark is
automatically adapted to the size of the previous one and can no longer be changed accidentally.

n%; Add moverment mark

0%5 Delete mowverment mark(s)

Copy path
[risert-pathy
| Paosition frarme k Individual size
Cupve type kAl __Ij Use size of previous item
Transfarm path 3

]'J" Custorm entry..,

B | Select all rarks

@ Ewery image with the setting Use size of previous item is marked in the Layout Designer with a

=

>

Now simply click and enjoy the effect.
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29 Zoom

With AquaSoft ® SlideShow you can also zoom into your images. If you want to show a particular section of
an image enlarged, you can generate this using the corresponding tools in the Layout Designer. In that
respect, you can freely choose the area which you would like to zoom in on.

You can apply Zoom and Camera pansto the Slideshow objects below:

ey E

Imane Collage Wideo

You might find it useful to skim through the movements tutorial first since the zoom function is based on the
movement path system.

Zooming into an image easily

)

Create a new slideshow

=

Image

and insert an image.

Click on the image in the Image list or on the Timeline, so that the image is shown in the Layout Designer
and the corresponding tools are enabled.

‘{;-
Select the J icon from the upper edge of the Layout Designer to enter the Camera pan mode.
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B | | E%ss!? % % | | Timemank 0sec 2 || [E

3

i = ,
BRI L T I R |
ders

T
Now click the —I icon. This inserts a movement mark. A position frame is now drawn around this additional
mark. Reduce the size of this mark by means of the position frame and drag the section to the place which is
supposed to be enlarged.

i_aynutDesigner
CCY 'T&\:@:D@@jﬁﬁn@é:: Tirne riarks |2 sec e

B S S EENEENE g R S S E e aNEs ol

So that the Transition does not have a disturbing effect on the Zoom, you can set the Transition in the
Object settings of the image to None or increase the Timestamps.

The 2nd mark is still marked (orange). First of all set the time there at 4 seconds. Then click the first mark in
the Layout Designer and set the value to 3 seconds or more.
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:ll.lx

I@ﬁi;}) 'fa.j@j%i,{g'|:%%jjTim_e-mark':IBsec s NE

You can see that, by changing the time of the first mark, the subsequent marks also change automatically. In
this way the movement set remains unchanged within the path.

@ The exposure time of an image is increased automatically if the time of the movement path becomes
] greater than the Duration set in the Image Object settings.

=

After clicking ™ you can play back the zoom effect.

Motion in the image

If you would like to zoom in on several sections of an image, you can now use a movement path in the image.
Imagine you have a group photo and now wish to zoom in on the individual persons. However, you do not wish
to constantly zoom in and out, but go over the faces in the image.

g
For that purpose, you can now insert an additional movement mark with the —l icon. Position the mark at
the desired final point.
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Layout Designer

If you now play back the effect, you will now see that a camera pan is possible within the image. Using the
time of the last movement mark you can control the speed. If you increase the time, the shot becomes slower.

Zooming out

You can have the image cross faded while you are zoomed in on the section, or first revert back to the overall
image size.

In order to revert back to the full size, insert a new movement mark. Please ensure that the last movement
mark is selected.

Layout Designer

j:lﬁ'f‘:ni.'.’:-'.-_ S e ey

The easiest thing to do is now to use the Custom entry. Retrieve this with a right mouse-click button or by

7
using the kﬂ icon.
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Layout Designer - Custom entry

[Mark. 4 - 11,00 sec| - 15
Width: oo [

Height: won [fy)
!Freely adjustable - |

2
it

Left: o Right: o [
Top: o Binttom: oo [

Curve bype! LSmooth CUrye x |

[ Relative input [ High accuracy

At Mark 4 set 500/500 as the Center and 1000/1000 under Size . As a result, the image at Mark 4 is
displayed in its entirety, again.

@ O O | T Bl B | | Timemarke [115ec 2 ||

-

If you would like to leave the image at the end exposed a bit longer, increase the Exposure tim e of
the image from the Object settings. After the end of the movement path, the image then continues
to remain on the screen.

Now simply click and enjoy the effect.

When aligning the movement marks, it may occur to you that they snap magnetically to other
movement marks and to horizontal and vertical lines of other movement marks. You can prevent
them snapping this way by holding down the Ctrl-key on the keyboard when moving the mark.
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Furthermore, the movement marks are also aligned to the grid which can be enabled using the

icon.

As you can see, it is very easy to zoom images. Simply insert movement marks and position them as desired
— and already motions enters your image.

The movement path can be changed using the Curve type. Select Select all marks by means of the J
icon and click in the Layout Designer with the right mouse button.

In the context menu which now appears, select Curve type -> Hard.

u%; Add mowverment mark

u.?‘&é Delete mowverment mark(s)

Copy path

Bosition frame »

Curve type 3 | ' Smooth
Transform path k ?_ Hard

r"~ Custom erntiy..,

5| Selectall marks

T

You will now see the change in the form of the movement mark. This is now square, in order to represent the
chosen Curve type.

g

>

After clicking =™ you can see the change in the zoom. The pan in the cunes is now Hard and is no longer
carried out soft.

2.10 Rotations

Just camera pans are not enough for you? You want more zest in your slideshow? Add freely definable
rotations to your images.

@ This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

@
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The following objects can be rotated:

e THY B

Image Text Particle Collage Yideo

It doesn't hurt to read the tutorial Movements first because the rotations are combined with movement paths.
The chapters Rotating text and Letting texts fly give more information about rotating text.

)+

Create a new slideshow

Image

and add an image.

Select the image in Image listor Timeline to display it in Layout Designer. The use the button in

Layout Designer to zoom out a little.

Layout Designer =5 0L ox

[T T SR AT ?fq’? - il | | Tirne matki |0 sec :_l: =]

| Lo it | b B 0|
i

Now you can use the green handle to rotate the image. Click it, hold the mouse button down and define the
rotation angle. Use the Position fram e around the image to decrease its size.
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L T T e R %4" - el | | Time mark: |0 sec :l =]

IR [ I e B IR R |

you want them to be displayed. You need the outside area for special purposes like e.g. images or

@ The black area in Layout Designer is the visible area. Images need to be positioned in this area if
texts that "fly" in from the outside.

To manually specify the rotation angle click on the image in Layout Designer and select Custom entry.

Layout Designer - Custom entry x |

i 500 twidth; C

¥ 270 Height: M [
Time: 0.00 sec [Fraet [

- Rotation;
Anale: Zmoe [t 0.1 Turns right

Left; 250 Right: 750 t,
Top: a7 [fs)  EBottom: 444 0
Curye type: |smooth curve - |
| Relative input [~ | High accuracy

Now enter the Angle under Rotation.
Beautify your Collages by rotating the images in the Collage. Texts can be rotated this way, as well.

Of course this is not all you can accomplish with the rotation functionality. Would you like to trace your travel
route with a car on a map? Then you can learn how to combine movement marks with rotations.
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L

==

b
In our example we let the car follow a road. First we add the image of the road using the = button. Instead
you can add your image of the map.

e

| Dbiject Starttime  Duration || @ O T %4’ Bt i et |n Sae :J B
-~ v @& 1, Strasse.jpg 00sec  2.1sec - B S i

| =
Fl " | 3 P HEA | g Y e

Now we need the car. Preferably it should be a PNG graphic with alpha channel.

@ Please consult the FAQ about how to create this type of graphic.

@

Add the car.
magelt =8 x| : = 8 x
[ .D.biect lStart time  Diuration | (T (=) Z:FL,I | E! ?SJ‘:? | % D@r; | | TFimeinare IIJ set :J B |

o @& 1, Strasse.jpg 0.0 sec 21 sec
Lo 8 2 puboDraufsi..  21sec 290,

| =
] T | 3 P HEA | g Y e
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Decrease the size of the image using the Position frame.

o —————
Starttime  Duration | (8, (= (% | H ;I%I‘if | B ] | Time matky [0 sec i B ‘
L t 1, Strasse.jpg 0.0 sec 21 sec —
Lo 8 2 puboDraufsi..  21sec 290,

‘ 1 . 3

Now you can start the tour. Add a movement mark
road.

You can adjust the time marks for each movement mark individually. Click on a mark, it will then be
highlighted. Change the time mark in the menu bar above the image.

P Chithy | 1 If%;_rlgg?' |D&E EEE.L| I -TimEf‘:‘lﬂrk:.llS sec :i I

L]

Now replay your show via

95
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Eventually the complete movement path should look similar to the following graphic.

Layout Designer | X

| Object Starttime: Duration G}& @b IQ} : El “EEEM? | E T : _ | Tirne marks |0 sec Ei i B
W t 1, Strasse.jpg 0.0 sec 2.1 sec -
Lo 8 2 puboDraufsi..  21sec 290,

‘ ‘ 1 . 3

The rotation angle can be larger than 360 degrees. This way you can simulate effects like the
skidding of a car out of a cunve.

o

2.11 Image effects

With AquaSoft ® SlideShow you can now also apply image effects to your images and in this way present
your images even more impressively.

In the Toolbox you will find the Image effects.

Camman

=

Frames
Masks
Colors
Custarn image effects

FH B ®H

The Image effects are subdivided into various categories. With the plusicon you can open up the individual
categories.
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5| Image effects

Delete all  Cutinto pieces Glow (Black)  Glow (Blue)  Glow (Red)
image effects

e B B B B

Glow COwhite)  Glow Crellow’  Mirroring Pin {top) Polaroid

Im age effects can be applied to an image very easily. Insert a few images into an empty slideshow.

In order to now being able to apply the Image effects to these images, simply drag the desired effect out of the
Toolbox to the image in the Timeline.

Image effects (B

Delete all  sEEFGEER-E Glow (Black)  Glow (Blue)  Glow (Red)
image effects

= B E =

Glaw (White} Glow (Yellow)  Mirroring Fin {top) Palaraid

Timneline FfElal

You will see the change in the Layout Designer. The effect becomes properly visible when playing back.
If you would like to assign an Image effect to several or all images select these images.

All images = Ctrl + A

Certain images = Ctrl + right click on the image

Select the Image effect with the left mouse key, then click right and select Apply. The Image effect will be
assigned to all selected images.
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ecks

Apply

Delete all
image effects

Glow (Red)

h

Polaroid

Increase icon size

Decrease ican size

h L Tahs left

Glow (White)  Glow (¥ &

Tabs on tap

Tahs right

Tabs atthe bottom

If you want to remove an Image effect again, in the category Common you will find the Delete all image
effects object in the Image effects.

, — B
) [ o O O

Delete all  §Cut into pieces Glow (Black)  Glow (Blue)  Glow (Red)
image effects

ia o ia 2= 2o

Glow COwhite)  Glow Crellow’  Mirroring Pin {top) Polaroid

Simply drag the latter from the Toolbox onto the image on the Timeline in the case of which you wish to
remowe an effect set.

In AquaSoft ® SlideShow Ultimate and Blue Net you can create and edit such effects yourself. A special
Dort gibt es einen speziellen Effect editor is available. It is explained in chapter Image editing.

2.12 Animated transparency

In AquaSoft ® SlideShow a transparency behaviour can be assigned to some Slideshow objects. This
creates impressive effects. For instance, it is possible to let an image or text slowly appear from a black
background and later disappear in it.

In this way images and texts can also appear semi-transparent on a previous image.
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You can apply the anim ated transparency to the Slideshow objects below:
[ & =
Image Text Collage Wideo

You will find the corresponding possibility for setting them in the Object settings of the respective Slideshow
objects.

Object Settings m o ox
il]hiet seis
| [ show object
Cruration: ;E,_DD SeC :_
7] Use default duration {Settings)
¥ Leave in place after replay
mw‘m‘ ) Transparencyl
g | Time: Esec : || Transparency: | [0z =]
o
& Click on the graph to add transparency points.
12
15
26
13? 2
e v
E 44
&0
'E 5
=gz
68
75|
21
27|
99
000 o025 050 075 100 125 150 475 20
Duration (in seconds]

Now with the left mouse button set markers in this system, which then form a transparency curve. On the left-
hand side you will find the value of the transparency (in %); at 100% transparency the image is completely
transparent (i.e. no longer recognizable), at 0% it can be seen completely. Above the curve you will find icons,
the meaning of which is:

1| Points are round, the course of the transparency animation is soft.

Points are square, the course of the transparency animation is hard.

B

If you hawe clicked a transparency marker (appears orange), you can delete the marker by clicking the
icon.

If you have changed the exposure time of the image or text, you can, by clicking this button, have the
transparency set adjusted to the exposure time.
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Mowe the markers by clicking an existing marker and keeping the mouse button pressed down. Now simply
move the marker to the desired spot and release the button again. In order to delete the animated transparency
entirely, you will have to remowe all transparency markers.

2.13 Background music

A perfect slideshow not only includes impressive effects, but also background music. The Timeline provides
its own sound track for Background music.

Click this sound track and the Background music menu is opened.

By means of the plus icon ﬁ you can insert music onto that menu.

If you click the song, you can make further adjustments.
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i Slldeshnw Background music
| Main settings
i Slideshow flaw = Background songs
End of slideshaw - q
— et
Transtions e - 123 [ i | BB
M i T >
E:j: [S:u:"jgfnusic Be] o bedia usichdstistiOT-TitkeB1, wina 1
o gt. 2 Jj O:iMediadMusichbmisth02-Tite02. way 0:02 H_Il
escription .4
L P 3 ﬁ O:vMediatMusichAisti03- Title03 way 0:00 [ ==
; ogo
1 SlideShaw-Flayer
Software Player
Standard Player [Di... |
Fade-in song iU.D sec L ‘ Start position iD.U sec o |
Fade-out song End pasition {D“U;Ec_:_|
Vel [0 =until end)
Start song after
Start next song after [minus values OF, for cross-fading)
‘E| | ok | |, Cancel -_| |! Help !

You can insert one or also multiple tracks. These are then listed below one another in the list. You
can change the sequence by clicking the track and moving it in the list with the mouse button
pressed down.

I:I]

Remowes a selected track from the list

2

Plays back a selected song

o

Opens the music settings

&

Fade-in song i|:|_|:| e X || A track can be gently faded in. In this case state how many
= second the fading in should last until the full volume should be
achieved.
Fade-out song i_n_'n - ;|l Songs can also be gently faded out. In other words, they are

getting more and more quiet prior to the end. Here set the time,
how long prior to the end the fading out should start.

Yolume 1o0% 3|} Specify here at what volume the track should be played back.

Start sang after i_n_'n sec :|l You can delay the start of a track. Specify here the length of the
= delay.

Start mest song after iT_'n sec ;|l If you do not want the following track to begin immediately,

specify here the length of the break between songs.

Start position 00sec 3 il It is also possible to only play a section of a track. Here you
. determine from what point in the song playing should start. For
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example, 20 secs -> The song begins at the 20th second. The
first 20 seconds of the song are not played.

0 -> From the beginning.

End position 00sec | Here you can determine when the song should end. In that

' (0 = unti endj respect, the timestamp in the song is to be selected again. If you
want to end the song after 2 minutes, enter 120 secs here.

Example: Starting and final positions

You wish to only play 1 minute of the song. Howeer, the part of the song which you would like to play back
begins at the 45th second.

Starting position = 45 secs

Final position = 105 secs

You will see the music in its own track in the Timeline. The sound wave display will have alternating colors to
make it easier to see when a title starts and ends.

The wolume of the background music can be set individually. In the next chapter you will learn how this is done.

Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ® SlideShow
does not support the use of music tracks which have been encrypted by DRM or similar procedures.

@
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2.14 Custom volume settings

For each title, no matter if it's Background music or a Sound object, you can separately adjust the volume.
This happens in the Timeline.

To get the line, click the wave form of the title. Each click creates a mark that can be mowed to adjust the
wolume. A right-click on such a mark will delete it. The line will be removed when the last mark was deleted.

Background music will be automatically faded-out when a Sound object starts. You don't need to do
m this manually. You can configure the fade-out volume and duration in the music settings.

2.15 Sound objects

If you have undertaken the desired adjustments with an object/image, you can drag it out of the Image list or
Timeline to the Toolbox. A window then opens for saving the template. Enter a name there.

Slideshow objects BT
= Default
[
ey & 7o [ 1|Q)
Chapter Collage Irnage Particle  Placehalder  Sound
Teit Video Colored Palse Play Inhite,
hackground transparent -

Afterwards you will find the template in the Toolbox under Slideshow objects -> Custom objects. Click the
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object and then select the images. These are then inserted with the desired template.

The Sound-object is usually used if a sound will only be played over the length of a certain number of images.
This is accomplished by using a Chapter. You can find an example in chapter Multiple tracks.

Here you can find a chapter about Sound-properties.

[ Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ® SlideShow
does not support the use of music tracks which have been encrypted by DRM or similar procedures.

@

2.16 Saving own templates

After you got a bit familiar with AquaSoft ® SlideShow there is a multitude of options for own objects waiting
for you. The goal is to reuse nicely designed compositions and thus saving of time. The principal is simple. You
know the different kinds of objects by now. Together with your comments and settings whole slideshows or
parts of them came into existence. Some parts are usable only for the slideshow they belong to, in others
there are elements that are commonly usable or at least a few times. If you created such elements you can
easily save them as new objects.

If you have applied the desired adjustments to an object/image, you can drag it out of the Image list or
Timeline to the Toolbox. A window then opens for saving the template. Enter a name there.

Create/Edit ternplate x

Mame: EImage - adjusted |

Title:  {Image, adjusted
Authar:

Description:  {1mage with Fant: Yerdana in size 36 I

Activate all objects whose file names should be adjusted when using the template.

Ohiject
- [] & 1. img_3357562 ipg

Afterwards you will find the template in the Toolbox under Slideshow objects -> Custom objects. Click the
object and then select the images. These are then inserted with the desired template.
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Slideshow objects &3

Fin, Pin, pink Pin, red Pin, white Sun Star
lightgreen
i
i &
e
i — L
Stor: Pine tree  Christrnas  Christmas Cloud Mearma
tree decoration

= Cusktom objects

m., |

Saving own text effects

This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

o4

If you made changes to a text effect and would like to save them, just click on the icon.

Edit text animatiot

Animation; |Tornadn - thaniged

Fadein | Fade cut

Effect: iZUUm *

Duration: !S.DD sec 3 |

Characters =
10 -

simulkaneously: o < . 41

Font width: 46— 100%
T T T T R

Fonk Height: _B— 100%:
A I T T R

Mumber of rotations: |2 po |

Center of rokation: |Iaft - |

¥ Randaom order | Activate alphablending

| Mavement. "] Rotate in direction of moveme

[#] Consider letter position

My ow ftextef

Start posikion: |Fixed path »
! 0% b
— Example kexk;
T GRS 1=_| Iy own ket effect
Specific path: |Sp|ra| ™

Mumber of points:

& Modulation

ll- (Cancel i

A dialog opens that lets you save the template.

105
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Save Text effect

You can save the Text effect for wour own use or export it
For distribution,

Enter the name for the Text effect here,

Mame; |Te><l: wihirl

Save .j h Expark ‘I h

After the Text effect was saved it will be added as a Custom text effect to the Toolbox and can now be
applied to other text/images.

Zoom toward edges

E Custom text ffects a— ——————

Saving own movement paths

@ This feature is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

=

Movement paths can be saved, as well. Click on the icon in Layout Designer.
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U%.; n@.ﬁ _§|'|: Time matk: |0 sec

A dialog opens that lets you save the template.

Save Movement path x

You can save the Movement path for your own use or
export it For distribution,

Enter the name for the Movement path here,

Name:  (Size c.hange

i | Expott (| Cancel |

After the Movement path was saved it will be added as a Custom movement path to the Toolbox and can
now be applied to other images.

Peek in (twice,
rotated)

= Custom movement paths  se—

=
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2.17 Using the SlideShow-Master

The SlideShow-M aster contains a series of slideshow templates which make it easy for you to create a
slideshow.

At lightning speed you can select images and music to create an attractive slideshow in connection with a
style.

Under File -> New -> Use SlideShow-M aster you can access the SlideShow-M aster.

1 ShdeShow-Master x

SlideShow-Master

The SlideShow-Master helps vou to create a professional sideshow with just a Few
simple clicks.

¥ou decide about the images and background music faor your slideshow. The wizard
creates an astonishing slideshow with one of your selected templates.

After creating the slideshow you can make Further adjustments and burn a video- aor
PeC- slideshow,

Click "Mext" to procesd.

Cancel

Click Next to begin designing the slideshow.

In the next step please insert images using the Plusicon.

Add images

o @2 [ & Almages

i e

img_763... img_216... img_278... img_335...
I
..........
Cancel | « Back: | |’ Mext = i

Then click Next.

Now insert your desired background music using the Plusicon.
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Add background music

B NEEER

L ﬁ OriMedia\MusiciArtistl01-TitleO1 wma

|#] Adjust duration of the slideshow to the duration of the background music.

319

Cancel

< Back | |f

Next > |

-

If you don't want to adjust the duration of the slideshow to that of the background music uncheck

this option. With this option enabled the duration of the images will be adjusted to the duration of

the music.

Next click Next.

Now select a style template.

11 ShdeShow-Master

Select style template

.| q Firnwall 16:9

Mo description available

Piruyall 4:3

Mo description available

Starships

|- Start preview |

Panorama
"N After the Flm title Faded in, yaour images move harizontally and

wertically over the screen to realize & panoramic visiv,

Your images fly in animation-like starships through space, while
o#| shooting stars light up here and there in the background,

Mot templates on the Inkernet. ..

(BT

Cancel

< Back | |}

et = |

With the Start preview button you can inspect the style template.

III_'.-"" S

A

With some templates you can enter a film title and further personal details. For that purpose,
simply click the personalization data directly and enter your desired text.
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1 ShdeShow-Master

Select style template

Film title

e

o)

Summer Holiday 4:3

‘our slide show starts out on & beautiful summer beach: the sun
comes up, vour film title Fades in and a shark swims by to prese,

I W Steel >
| Start preview | More templates on the Internet...
Cancel < Back | | et =

Next click Next.

Now you can decide what the next step should be.

1 ShdeShow-Master
Finish

Edit slideshow
After creating the slideshow you can continue to adjust ik, Images
can receive comments, sounds, animations and much mare,

i

Burn PC slideshow to CD
Creates a data CD that can be played on a PC, You can also use
this methad to archive your slideshow for later changes,

Burn ¥ideo to D¥D or (S)¥CD
Burn the slideshaw to a video-C0 or -DVD ko play it on wour
DWD-Plawver, You will then not need a PC ko view the slideshow.

‘t.
<
[«

Cancel l < Back J

Edit slideshow: Opens the style template with the images in AquaSoft ® SlideShow for
editing. It is now possible to make individual adjustments.

PC DiaShow auf CD brennen:  This option opens the CD Wizard and you can record the show on a CD
or prepare it for passing on. The CD recorded can then be reproduced on

a PC (not on a DVD player).

Video auf VCD, SVCD oder This option opens the Video Wizard. With this the slideshow is recorded
DVD brennen: on a video CD or DVD. First the show must be converted into a video.
3 Properties of slideshow objects

As you hawe already learnt in the previous sections, there are so-called Object settings for the Slideshow
objects. In these you can configure specific settings for the respective objects.

You will find the Slideshow objectsin the Toolbox.
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The Object settings can be shown fixed on the user interface (always embedded) or also only displayed when
required. If you do not show them on the user interface, you can access the Object settings at any time by

right-clicking the relevant object.

The following fundamental properties are available with every object:

|| Show object

.

Duration: E,UU seC .

|| Use: default duration {Setkings)

|¥] Leave in place after replay

& ==

Storyboard.

Determines whether the object should be shown when playing back the
slideshow.

Here you can set the exposure time. In other words, how long, for
example, an image, text or video is supposed to be shown. The cross
fading effects take place within this exposure time.

In the Slideshow settings you can set a standard exposure time for
your Slideshow objects. If you change the exposure time there, this
applies to all Slideshow objects in the show in the case of which the
standard exposure time was enabled and to Slideshow objects which
are newly inserted.

Normally an image or text is cross faded by a subsequent image. In
that respect, the image lingers. If it is not desired in the case of a
particular animation, the lingering can also be turned off.

If you deactivated an image of your show (Show object deactivated), it will not be displayed
anymore in the Timeline. The Timeline displays only objects that are supposed to be
replayed. If you want to reactivate an image you can do this in the Image list or in the
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3.1 Image

In the Object settings of an Image you can configure the following settings:

Image

Object Settings = 8 x|

!Dh]ect settings
|&! Show object
|

Duration: 5,00 sec = |

[¥] Use default duration (Settings)
¥ Leave in place after replay

M 1 Saund Transparency
DO oL T =

= File name

» |

Oi\Medis|Imagestima_1330704.ipg B

[=I Transition

iﬁa_qdnm transitian = | | Adijust .|
= Background

Fill colar: E

=/ Position

Aspact ratio: EKeep * |
Aligriment: |im) Center - |

|7 | Rotate in direction of movement

1

5

Rotates the image counterclockwise.

2]

Rotates the image clockwise.

S

Opens the Image editor.

|#

Specifies a movement path.

=

Specifies a camera pan.

File name Shows the path and file name of your image.

Aspect ratio Images have an aspect ratio which is comprised of the height and
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Alignment

Rotate in direction of movement

Fill background

Transition

width of the image. If an image differs from the aspect ratio of the
slideshow set, it can be decided here how the image should be
represented.

Keep: The image retains borders when being played back.

Crop: Parts are cropped from the edge of the image until the image
fits into the correct aspect ratio without edges emerging.

Distort. The image is inserted into the aspect ratio of the slideshow,
whereby a distortion of the image takes place.

Determines the position of the image on the screen.

If you assigned a movement path to an image you can let the image
automatically rotate along the path. This function is only available in
AquaSoft ® SlideShow Ultimate and Blue Net.

On = Background gets a color filling when display size of the image
is reduced.

Off = Background doesn't get a filling and the previous object "looks
through”. For images inside collages or Picture-in-Picture effects it
has to be Off.

Automatic = The slideshow sets filling to On automatically for
images/videos/collages in the first track. If you mowve an object to the
second or a lower track filling will be set to Off. This way Picture-in-
Picture effects can be created quickly. If you want to the value to
remain select it from the drop-down box.

Here the Transition can be set or also deselected. For that purpose,
in the drop-down list there is None as the first option. With the
Adjust button, the transitions can be configured. You can also
obtain a preview of all transitions there.
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Font

(1] arisl  AbCoEfGHi v 26w [ ||+
| =i Style Alignment

AA =B=-==0Bc
= Text

= Effgct :

A 603D S EBorder color: |--|

P!nimatic-n: )

Alphablending |

— Rotation around text Showy texk with image

I center L}

The possible formats are almost always self-explanatory through the icons and you are no doubt familiar with
them already from other text programs.

The Alignment, however, has a minor peculiarity.

E% Positions the text at the lower edge of the screen.

E% The text is shown in the center of the screen.

Eﬁ Positions the text at the upper edge of the screen.

Places the text freely in order to determine the position in the image individually.

@ The text is shown underneath the image. That also applies if the image is shown reduced in size.

If you don't wish to have separate text animation, activate the option Show text with image.

Should the text be shown animated, you can select various ready-made animations from the list. You can still
adjust the animation using the Edit button. You can also see a preview of the animations there.

Rotation around text center refers to animations in which the text is rotated. Under Edit you can also
determine a different rotation center.

With Behavior along a movement path you can specify how text gets displayed when it moves along a
movement path. You can choose if the whole text shall mowe as a block or even as separate characters along
a movement path. In the latter case the characters "snuggle up" to the path.
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Sound
= Sound
O\ MedialMusict Artist01-Title0 1 .wma BT
&' Record | Duration: 03:19.904 |ﬁ|
= ¥olume
Yolume: 1IZIIZI T

[¥| Fade background music {Sektings)
= Repla_yf behavior

Start position: ?D,DD - [
120 Adjust display duration ta sound duration
7} Continue sourd after end of image

17} Fade-out sound after end of image

s |
- |

Folder icon

Play icon

Record

Volume

Fade background music

Adjust display duration to sound duration

Continue sound after end of image

Fade-out sound after end of image

Using the yellow folder you can assign commentaries or
pieces of music already included to an image.

Plays back the music file assigned to.

Opens the Sound Wizard and you can then record a
commentary to go with the image.

Determines the wlume of the sound when played back.

You can determine whether the wvolume of the
background music should be faded/decreased when
playing back the sound.

Plays back the sound in its entirety and thereby adapts
the exposure time of the image to the length of the
sound.

With this option the image can have a shorter duration
than the sound. The sound then simply continues to be
played on into the next images until it has come to an
end.

Should the exposure time of the image have come to an
end, but the sound be longer, with this option the sound
is faded out at the end of the image. Under Duration you
can set the fading out time.
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Transparency

Animated transparency is described in the design options under Animated transparency.

3.2 Text

In the Object settings of a Text object you can configure the following settings:

Object Settings

|Object settings
| [#]5haw obisct
Duration: (5,00 sec = |

[¥] Use default duration (Settings)
¥ Leave in place after replay

| -._ Ttansparency

=/ Font

prisl  AbcoEfGH] v 26w [ lx

= Style Alignment

AA B==—=—
= Text

Text
[=I Effect

AE\D € Eordercolor; [N -
CEARE S
Delete text effect . ! T Edit |

= Potation around text
— center

| £ WOE v.

The Text Object settings do not differ from the Text Object settings for images. In this case only the Show

text with image option is not available. The Text object is an independent Slideshow object, nonetheless, it
can be faded into images and videos.

If you want your text to be moving along a movement path, please hawe a look at chapter Text with movement
paths.

Transparency

Animated transparency is described in the design options under Animated transparency.
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3.3 Video

With the Video object you can configure the following settings in the Object settings:

Object Settngs
|Dbject settings

[#} Show object
Ciuration: 515,31 sEC :-'

¥ Leave in place after replay

1o NERESPE

"'=5._g: Tr'an-_:|::.a FEMCY

To
= File name
"0\ Medial video' vid_3392284Big ek, wmy" &)
Durakion; 00:00:14.71
Skart bime: Q,DDT:_I
|| Play complete viden
= Transition
;l;lancllluljm'i:rar;s-i-ti-nn = |_Ed]gt_|
i Background
Fill: ;_.jC\utomatic {on; *' &
Fill calor: |- 'l
I=! Position
Aspect rakio: '@3 -
Alignment: * Center i

7| Rotate in direction of moverment

Video

File name

Duration

Start time

Play back video entirely

Aspect ratio

Shows you the path and file name of your video. Using the yellow
folder you can also exchange the video for another video file.

If you have once changed the playback time of the video, you can set
the correct video length again with a click on the time.

Here you can specify from which position a video is to be replayed. If
you don't want to show the first ten seconds enter 11.

If the option is selected, the full length of the video is played back. If
you deselect the option, you can set the playback duration
individually.

Videos, just like images, have an aspect ratio, which consists of
width and height of the frames. If a video differs from the aspect ration
of the slideshow you can here decide how to display the video.

Keep: The video retains borders when being played back.
Crop: Parts are cropped from the edge of the video until the video fits
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into the correct aspect ratio without edges emerging.

Distort. The video is inserted into the aspect ratio of the slideshow,
whereby a distortion of the image takes place.

Alignment Determines where the video is supposed to be positioned on the
screen.

Rotate in direction of movement If you assigned a movement path to a video you can let the video
automatically rotate along the path. This function is only available in
AquaSoft ® SlideShow Ultimate and Blue Net.

Fill On = Background gets a color filling when display size of the video is
reduced.

Off = Background doesn't get a filling and the previous object "looks
through”. For images inside collages or Picture-in-Picture effects it
has to be Off.

Automatic = The slideshow sets filling to On automatically for
images/\videos/collages in the first track. If you move an object to the
second or a lower track filling will be set to Off. This way Picture-in-
Picture effects can be created quickly. If you want to the value to
remain select it from the drop-down box.

Transition Here the Transition can be set or also deselected. For that purpose,
in the drop-down list there is None as the first option. With the
Adjust button, the transitions can be configured. You can also obtain
a preview of all transitions there.

= ¥olume

‘olume: {1003 :

¥| Fade background music {Settings)

Here you can determine if the background music should be faded out when the video is played back. If the
video does not hawve its own sound, but perhaps a noise has been recorded, set the wolume of the video to 0%
and remove the check mark beside Fade background music.

Transparency
Animated transparency is described in the design options under Animated transparency.
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3.4 Sound

With a Sound object the following settings are possible:

Object Settings
|Dbject settings

[#} Show object

Duration: ;?Uﬂjfl seC :,

¥ Use default duration {Settings)
| i].]].SI:-un.d.|

= Sound

OiMedialMusici Artisti01-Title01  wima

| & Record

= ¥olume

Yolume: 1100 % = |

[¥] Fade background music {Settings)

=l Replay behavior

iﬁ,DD seC :_..

Stark position:

) Continue sound after set duration

(") Fade sound after set duration

utoduratior |l T zEr i |

B =

:| Duration: 03:19.904 |EI

(0 MedialMusic| Artist|0-Titlens mp3 (3]}

=

& Recaord i

Volume

Fade out background music

Play back the full length of the
sound

Continue to play the sound after
the duration set

Fade out the sound after the
duration set

With the folder icon you can insert or remove a music file. The track
selected is shown on the left next to the icon.

Plays back the music file

Opens the Sound Wizard. With this you can record a commentary
for the image via a microphone connected to the PC. You can find
more on the Sound Wizard here.

Displays the wlume at which the sound is supposed to be played
back.

If this option is enabled, the background music is faded (vwolume
decreased) when the music file is played back.

If this check mark is selected, it means that it plays back the full
length of the Sound object.

With this option the sound can receive a shorter exposure time. The
sound is then simply played on into the next images until it has come
to an end.

Should you wish to only play back the sound for a certain period of
time and then end it, you hawve to select this option. Under Duration
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you can set the fading out time.

The wlume of a sound object can be controlled individually. You will learn more about this in chapter Custom

wlume settings .

does not support the use of music tracks that are encrypted with DRM or similar methods.

W Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ® SlideShow

@

3.5 Collage

With Collage objects you have the following possibilities for settings:

Dbj.en:tSet-ti.')gf_, = o X.

|Object settings
[#! Shoiw object
Duration: 5,00 sec = |

[¥] Use default duration (Settings)
[¥|Leave in place after replay

.!IITIGEIE| ix Transparency

D O|ate Bl =
[=| Title

|F_.i.-Transitinn

%.Ranl.:il.:-m kransikion - I=_@;di'-|5t | |=
=l Background

il [Automatiz on, + | @

Fill colar: I -

=/ Position

Aspeck ratio: :@ -
Aligrment: |;_Cen-ter l

[~ Rotate in direction of movement

Image
Title

Aspect ratio

Here you can enter the title for the collage. It serves for a better
oveniew in large slideshows.

Images have an aspect ratio which is comprised of the height and
width of the image. If a created collage differs from the aspect ration
of the slideshow you can here decide how to display the collage.
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Alignment

Rotate in direction of movement

Fill background

Transition

Transparency

Keep: The collage retains borders when being played back.

Crop: Parts are cropped from the edge of the collage until the
collage fits into the correct aspect ratio without edges emerging.

Distort. The collage is inserted into the aspect ratio of the slideshow,
whereby a distortion of the image takes place.

Determines the position of the Collage on the screen.

If you assigned a movement path to a collage you can let the
collage automatically rotate along the path. This function is only
available in AquaSoft ® SlideShow Ultimate and Blue Net.

On = Background gets a color filling when display size of the collage
is reduced.

Off = Background doesn't get a filling and the previous object "looks
through”. For images inside collages or Picture-in-Picture effects it
has to be Off.

Automatic = The slideshow sets filling to On automatically for
images/videos/collages in the first track. If you mowve an object to the
second or a lower track filling will be set to Off. This way Picture-in-
Picture effects can be created quickly. If you want to the value to
remain select it from the drop-down box.

Here the Transition can be set or also deselected. For that purpose,
in the drop-down list there is None as the first option. With the
Adjust button, the transitions can be configured. You can also
obtain a preview of all transitions there.

Animated transparency is described in the design options under Animated transparency.

3.6 Chapter

In the Object settings of the Chapter only a section name can be specified. This serves to provide a better
subdivision of your show. This chapter name will be loaded into SlideShow-Manager later,provided it is
installed. The chapters can thus later be selected individually in a CD/DVD menu and played back.

3.7 Particles

The Particle object shows your images in a minimized form and mowves them on the screen.

@ This feature is only available from <%°PRODUCERPROGRAMNAME_R_ORIG%> Premium.

@
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In the Object settings of the Particle object you can adapt the representation to your wishes.

|Partic|e

=l Images

[ i MedisiImagesiimg_4795551.ipg i_D_|
| Cv\MedialImagesting_1930704.jpg :?
| O:\Mediatimagesimg_5009631.jpg ekl
[= Particle

Direckion: EE?D,DD @ % | (Angle)

Speed: IDJDD : (Travel/second)
Farticle size; EiDJDD 2 | (% of image size)
Murber of particles: 2D :

Mawermenkt: S|nus WAVES =
Strength of E-i-l..'.l.,-l.:l-ﬂm : Lrit

mayement: L !

Frequency of los0 = unit

masernent: el ik

%Ei Inserts additional images into the Particle object.

i D i Removes selected images from the Particle object.

ek 270,00° = | (Angle) I Und_er Dire_ction you can set in which direction the
S — particles disappear.
Directions:
0 degrees = the particles mowe out of the image
towards the right
90 degrees = the particles mowe out of the image
towards the bottom
180 degrees = the particles mowve out of the image
towards the left
270 degrees = the particles mowe out of the image
towards the top
Spead, 10,00 = | (Travelfsscand) I Y_ou set the pace of the movement un_der speed. The
D higher the value is, the faster the particles fly over the
screen. A value of 0 means no speed. The particles won't
mowe.
Particle size: 10,00 * | (% of image size) | Here you determine the size of the particles. The size

-

will be calculated based on the size of the Position
fromein Layout Designer. If the Position fram e takes
up the full in Layout Designer and Particle size is set
to 10% then the Particles will be 10% of the size of the
Position frame. If you reduce the size of the latter the
Particles become smaller, accordingly.
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=0 - | | With the number of particles, you set the quantity of

Mumber of particles: )
particles shown.

Here you can select an animation for the particles.

Movement: Sinus waves -] |

Strength of 10.00 | Unit | Here you set how strongly the movement should be
i i) - . .

mavement: = carried out. The higher the number, the stronger.

Frequency of 0,50 = | it | The frequency specifies how often the movement is

mavemsnk: it o

carried out. The smaller the number, the lower the
number of movements.

The Particle object can in addition also be provided with movement paths. In AquaSoft ® SlideShow
Ultimate and Blue Net you can even rotate the Particle object.

4 Controlling the slideshow

4.1 Automatic course

It is standard for the images in a slideshow to be automatically played back in sequence. In that respect, you
determine in the Object settings of the Slideshow objects how long an image, text or collage is shown and
when to switch to the next object.

No special settings are necessary to accomplish this with AquaSoft ® SlideShow.

4.2 Manual control

Should you wish to move on manually during the show, you can configure the SlideShow Player accordingly
in the SlideShow settings.

The SlideShow settings always refer to the current show open.

From the menu bar you can open the SlideShow settings using the icon. Alternatively you can also

open the dialog using Slideshow -> SlideShow settings.
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Slideshow settings x

Slideshow flow

(=l Display
End of slideshow S T 7
Transitions & low replay quality can help speed up the slideshow on a slow computer.
Music settings
 Background music Replay quality: iDptimum -

Description & glideshow can be plaped in any resolution. Only the proportions are important. They

: - Logo can vary with the purpose of the slideshow.
Bl SldeShawRlayet Aspect ratio: |r175::§[VDVD, wide screen monitar) - |
Software Player

Standard Player [Di... | M_

Select the SlideShow-Player to uze for plaving the slideshow:

ISlandald Flayer [Direct] - | |; Configure plaper I

s

oK | |, Cancel -_| || Help I|

Via the Basic settings you can access the Player configuration directly.

Slideshow settings

= Slidesh | i
ie- 58 2R Standard Player (DirectX)
- Main settings

: Slldeshotfv flow Display
- End of slideshow =
- Transitions 0 Full screen [”| Change graphic mode

i Music settings
Background music -
D escription Antialigsing: |Mone  ~|
| loge Havigation bar Control
|z} SlideShow-Player S =
+ Software Player

1 Wfindow mode

|¥] Fonward/B ack,

Forward/back per mouse click

ndard Player (0.

7| Play/Fause [ Start paused

7] Volume @] Place over image

|| Catalog

IntelliLoad

SlideShow works with an inteligent preloading procedure that optimizes pauses during the
presentation by loading the next images.

Time, which InteliLoad will preload; !10 T

I | lgnare InteliLoad at start

|E |\ QK \| |. LCancel 1‘ || Help _||

The Start paused option switches the show over to being continued manually. You can then continue the show
using the cursor and scrolling keys.

If you activate Forward/back per mouse click in the dialog, you can continue your show by clicking the
mouse.
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4.3 Automatic and manual course mixed

With AquaSoft ® SlideShow it is likewise possible to continue parts of the slideshow manually and let other
parts play back automatically. You can alter this as you please.

In the Toolbox you will find two Slideshow objects for this purpose:

B

Pause Play

|| & Default - |
: . |
OYeH1Q
Chapter Collage Irnage Particle  Placehalder  Sound
: | | | .
Teat Widen Calored Pauze Play \White,
background transparent -

These two objects make it possible to switch between continuing the show manually and letting it run
automatically. By double-clicking or by drag-and-drop you can insert the objects into your show.

If you, for example, insert the Pause object behind the 3rd image, the show will stop before the 4th image and
wait for you to continue using the keyboard or mouse.

The manual replay can be interrupted again with a Play object. For that purpose, insert the Play object at the
point where the automatic course is desired.

Artificial pause:

You can also insert a Play object directly behind a Pause object. Thus, the show will be stopped at the image
before the Pause object and, as soon as you continue, the show continues to run automatically.

You can also use the Space bar to pause the show during replay. When you hit thr Space bar again the show
continues.

£k If you convert your show into a video DVD, this function of the two objects is lost. To pause a video
4 DVD, you have to use the pause key on the remote control.

4.4 Repeating the slideshow infinitely

|
From the menu bar you can open the Slideshow settings using the = icon. Alternatively, you can also
open the dialog via Slideshow -> Slideshow settings. Under End of slideshow you can enable the Repeat

current slideshow function.
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Slideshow settings

= Slidesh [ ;
- 2R End of slideshow
ain settings

Slideshow flow vl of shdeatiom
End of slideshow
Tranzitions

Music settings 0 Aepeat curent slideshow

Background music

‘when the slideshow rung through entirely, there are several choices

=l B B
Description _) End now

- Logo
= SlideShow-Player ; sin Il the zlideshom was stopped maritallp
Software Plaper
Standard Player [Di...

) ask user what to da

QK \| | LCancel ‘ | Help

~  Ifyou convert your show into a Video-DVD this functionality will be lost. If you create your Video-
4 DVD with SlideShow-Manager you can there activate the repetition of the of replay.

5 Export options
5.1 DVD-Player

For the DVD player your show must be converted into a video and then burned as a video DVD. This function is
provided by the Video Wizard and by SlideShow-Manager. SlideShow-M anager can even burn multiple
shows on one DVD that can then be selected in from menu.

Video Wizard

With the Video Wizard you can quite easily burn your show onto a DVD and thus play it back on the DVD
player. Under Wizards you can open the Video Wizard.
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d - Create DVDs anc
Video Wizard

What kind of CD/D¥D do you wish to create?
71 SNCD (Super-Yiden-C0)
1 9CD (Video-CD)
(1 HD-Videa

For experienced users:
71 Create custom video

All video creating settings {qualicy, solution, bit rate etc.) can be adjusted here.

71 Burn video to COJDVD

VIDEO e =
Burn existing video in MPEG-Format to DYD or (SWCD, respectively

Click "Next" to proceed.

Cancel

Premium and Ultimate

Videoassistent

Brennen
=2 pmm ER s [
Bluray AVCHD DVD SVCD VideoCD  ausDatei

Video-Ausgabe
FECEE G
® RCN=joR 3N~
WMy AVI MPEG WebM

Q&R a

Anim, GIF  Einzelbilder

Abbrechen | F

Blue Net

DVD

Creates an MPEG 2 video and burns it onto a DVD as a video DVD.
Resolution: 720x576

SvcD

Creates an MPEG 2 video and burns it onto a CD as an SVCD.
Resolution: 480x576

vCcD

Creates an MPEG 1 video and burns it onto a CD as a VCD.
Resolution: 352x288

Select the DVD option. Only use VCD or SVCD if you have a CD burner and no DVD burner. In this case we
recommend SVCD. It has a higher resolution than a VCD and thus thus result on a TV is better. Then click

Next.
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izard - Create DVDs and (5

Settings

7] Carreck TY-Margins

Every T¥-Set cuts off part of the edge of the film. How much varies from sef to set, To
rmake the Full picture visible the wizard can export the images smaller.

25 Bl

[¥] Burn movie bo CO/OVD afterwards

7| Delete File aFter burning | CD{DVD-Burner sattings
‘ideo stann;l.D,QL 43 v | PaLis European Standard (25 Images/sec)
VAOED Viden file:
CiiMedial showsslideshow. mpg @

Click "Mext" to proceed.

Cancel I < Back - Iext =

Premium and Ultimate

I Videoassistent

Brennen als DVD (16:9, PAL)

& PAL Es wird eine 16:3-DVD erzeugt, da Ihre Show dieses

= Seitenverhaltnis aufweist,

{71 NTSC

Brenner: E: (PLDS DVD+-RW DH-16465 - YD12) Andern...
Brenngeschwindigkeit: Max
Medium; Kein Datentréger {ca. 24,60 MB bendtigt)

= Erweitert

Bitrate: i} 8,00 MBit/s

|1 fliissigeres Video durch Interlacing
|| Fernsehrander korrigieren (0 %)

VIDED

W Erzeugtes Video speichern in:
P: Media\Shows'diashow.mpg =

I | nicht brennen, nur Video erzeugen

Abbrechen | < Zurtick | | Weiter > .|

Blue Net

In the settings dialog you can set various options. The TV border correction is required if the television frame
cowers up the \isible area at the edge. E.g., the first character could be missing or be displayed incompletely
from text that starts directly at the edge. Or the top or bottom of the characters could be chopped off. These
settings depend on the TV and manufacturer.

The Video standard is automatically set to PAL, the European video standard. NTSC can also be set if you
need the American video standard. The aspect ratio is automatically adjusted to the aspect ratio of your
slideshow. If you have created a 16:9 show, PAL (16:9)is automatically set. With a 4:3 slideshow PAL (4:3) is
selected. A 4:3 slideshow can not simply be burned as 16:9 show, and \vice versa.

Before the DVD can be burned, it must first be converted into a video. An *.mpg-file is created in the process.
This needs to be saved to the hard disk prior to the burning process. You can decide the storage location and
the name under Video file. You can also choose to activate the option to delete the video file after the burning.

Then click Nextand Create video. The process of the video creation can require some time.

If you want to burn more than one CD/DVD with your show you don't need to repeat the process of the video
creation for each one of them.
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You can access the Burn video on CD/DVD option in the Video Wizard.

d - Create DVDs and

Video Wizard

What kind of CD/D¥D do you wish to create?
) DYD
71 SNCD (Super-Yiden-C0)
1 YCD (Videa-CDY
(1 HD-Videa
For experienced users:

71 Create custom video

All video creating settings {qualicy, solution, bit rate etc.) can be adjusted here.

121 Burn video to COJDVD

VIDED

Burn existing video in MPEG-Format to DYD or (SWCD, respectively

Click "Next" to proceed.

Cancel

Premium and Ultimate

Videoassistent

Bluray AVCHD DvD SVCD VideoCD | ausDatei
Video-Ausgabe
»> L 00
VIDEO 4 b d !&
g WMy AVI MPEG WebM

MP: MZTS
e
MOV MKV Anim, GIF  Einzelbilder

Abbrechen | F

Blue Net

Here you can burn a video file already created (mpg video), which you have saved on your hard disk, onto a CD/
DVD.
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d - Create DVD's anc

Burn an existing video to CDIDVD

Video File:

OiMedial Shows\slideshow. mpg |3
Video bype:

71 DYD-video

7 Super-yideo-CD (SYCDY
(71 Widen-CO (WCD)

| COYDND-Burner settings

VIDED

Click "Next" to proceed.

Cancel | < Back { Iext =

Premium and Ultimate

=~ Videoassistent

Aus Datei brennen

Dateiname: P: Media\Shows'diashow.mpg =

Dieses Yideo wird als DYD gebrannt.

Brenner: E: (PLDS DVD+-RW DH-16A65 - YD12) Sndern...
Brenngeschwindigkeit: 2 x {352 KBfs)
Medium; DVD+R (4,38 GB Kapazitat, ca. 0 Bytes bendtigt)
=l Erweitert
| = video
MPEG-2 video, 720x480 mit 29,97002937003 Bilder /s
VIDED = Audio
ATSC Af52A (AC-3), 48000 Hz, Stereo

Abbrechen | < Zurtick | | Weiter > i

Blue Net
Specify the relevant mpg file and what type of video is concerned.

SlideShow-Manager

In AquaSoft ® SlideShow Ultimate and Blue Net you can also use SlideShow-Manager to burn your
CDs/DVDs. It allows to burn multiple shows on one DVD and to create a DVD menu. If you're using
SlideShow Premium and want to use SlideShow-Manager you can purchase it as a separate product.

You can open SlideShow-M anager from the Wizards menu.
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Templates

= e

High-quality preview

1 Agquasoft

)

Wide-screen

9

AguaSoftPremium AquaSoftiiitimate: Introduction
=1 Unobtrusive backgrounds
1 — il —
o e I

B

AltPapier Bottom of the sea Blue veil Yellow veil Gray vell

! R o

o B

Green veil Lilac weil Red vel Waves

Aad

iditional templates on the Internet | New template |‘r Edit template

Z

Select a template for your DVD menu and adjust the individual settings for the menu.

Under DVD-M enu specify aspect ration and video format.

Vo Templates | ™7 Menu | E= Cush

C-Ment @j DYD-Menu

Aspect ratio

@43
160

Yideo format

@) PAL
(7 NTSC

Play

|7 wher using "Play all' restart after last title

By clicking the @ button a dialog for burning the shows opens. Select Video DVD.

Burn

Burn project

Wiriting speed: Max

Export

[Pl |create voBs

Burmer: H: (PHANTOM DYD-RAM DYDR Y10 - 88.0)

v i Extended, ., 1

Taroet Feider: =
Memory space
FOO'ME 4.3 GB 7.8GE
Tokal duration; 0:35 Required space on the COJOVD:; ca. 26.61 MB,
Slideshows: 1 4.489,25 MB are available.
Chapter; 0
i Cancel l | < Back 1] l, Mext = ﬂ
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With Burn project you create a video DVD. Click "Next" and "Export project".

You can find an extensive description of SlideShow-Manager in the help files of SlideShow-Manager. You

can find it under "Help" in SlideShow-Manager .

5.2 PC-Show

Your slideshow can also be played back on a different PC, on which AquaSoft ® SlideShow is not installed.

The CD/Archiving Assistant will assist you in burning your slideshows with all the data to a CD/DVD or

archiving them on the hard disk.

Under Wizards you can open the CD/DVD and Archive Wizard.

I ED/DYD and Archive Wizard

Select task

Creates a self-starting slideshow CD that is playable on any Windows-PC,
This €D includes all original files (images, music ekc.) and the Slideshow-Player.
An installation on other computers is unnecessary,

Maote: This CDis not supported by DYD-Players. Use the video wizard For that

puUrpose.

7 Archive slideshow, prepare C0 or distribute slideshow

Copies all files needed for the slideshow into one falder, or creates a ZIP-file.
Ewverything is included: images, sounds, background music, SlideShow-Player
ekc,

This way you can exkrack the slideshow £.g. to USB-Sticks, external hard
drives. and it is still possible to burn it to €D afterwards.

Click "Mext" to procesd.

Cancel « Back | | Mext =

After selecting the task, click Next.

Creating and burning a slideshow CD:

I ED/DYD and Archive Wizard

Settings

Slideshow-C0 title:
‘Wacation 2010

[~ |Burn all necessary fonts

| Protect images from access

Protects your images so they cannot be accessed Fram the outside.
Attention: Mever delete vour originalimages and slideshaws! \ihen protected,
the files can only be played with SlideShow-Player, but cannot be extracted.

" | create IS0-CO-image only, don't write

i

CO/DYD-Burner settings | | Select temporary folder

Click "Next" to proceed.

Cancel < Back | |‘ [lext >

Specify a title for the CD/DVD. This title is used as the name of the CD/DVD.

Should you use fonts in the case of which you are not sure that they are installed on other PCs, you can also
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burn them onto the CD/DVD.

Protect images from access:

Should you wish to pass on the CD/DVD, however not permit access to your images, you can have your
images protected. This function is not suitable for archiving, since this show can no longer be edited. It can
only be played back. It is no longer possible to restore the images. You should not delete your original images
from the hard disk.

If you only want to create an ISO select the respective option. In this case the show will not be burned.

Click Nextto start the selected process.

Archiving the slideshow, preparing the CD or passing on the slideshow

This option enables you to save all data (ads file, images, music) in a common directory. This option is also
very well suited to archival storage. In this way the slideshow can also be saved on external data carriers (hard
disks, USB sticks ...).

0 CO/DVD and Archive Wizard

Seftings

The wizard assembles all Files needed For the slideshow,
150 Copy slideshow ta directory
Target directary: OiMedial ShowstYacation 20101 |]|

1 Create ZIP-flle

I Copy SlideShow-Flaver
|| Copy all necessary fants

|| Protect images from access

Protects your images so they cannot be accessed from the outside.
Attention: Mever delete your ariginal images and slideshows! \When protected,
the files can only be played with SlideShow-Player, buk cannot be extracted,

Click "Mext" to pracesd.

| Cancel < Back [ | Plest > i

In order to sawve disk space, you can pack all the data into a ZIP archive.

If you use fonts in the case of which you are not sure that they are installed on other PCs, you can copy these
as well.

You should copy the Slideshow player in order to be able to play back the show on computers on which
AquaSoft ® SlideShow is not installed. Without this player you cannot otherwise play back the show.

Click Nextand then click Start. Now all necessary data for the show will be copied into the folder specified or
combined into a ZIP archive.

5.3 Additional video formats

With AquaSoft ® SlideShow Premium and AquaSoft ® SlideShow Ultimate and Blue Net you can
convert your shows into further video formats.

For that purpose, select the User-defined video option in the Video Wizard. In the dialog you can now select
additional formats under Video format.

Check in advance with which codec videos have to be created, so that your DVD player plays them back
(Operating Instructions). Then check whether this codec is installed on your PC. If not, you have to install the
codec.
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zard - Create DVDs ani

Video settings

Video Format:

e
(Cl

s
Resalution: EQuarterE-\fm\f\gﬁgﬁgﬁu’;ﬂ
Aspect ratio: 4 IE 13 a (4t H)
Frame rate: 25.0 @ fps

Compressian: {Uncompressed - |

Compression:

VIDED

Cancel I < Back: | i [et = I

AVl-video
AVl is a widely used video format and will be played by newer DVD players.

Set the desired resolution and under Com pression, you select the appropriate codec.

Please check first which codec has to be used for the creation of these AVI-videos so that your DVD-player will
be able to play them (Operating instructions). Check to see if this codec is installed on your system. If not, you
must install the codec. AquaSoft ® SlideShow doesn't provide any codecs.

In our FAQ you can find further informationen.

@ Please note that an AVIvideo should not be larger than 2 GB. Most players will not play a large AVI
movie.

@ Not every codec supports all resolutions.

WMV-video
This format is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

For the creation of a video in WMV format, you should install a recent version of Windows Media Player.

Using the WMV format, you can use a very high resolution for the video. The finished video can be played with
Windows Media Player. Currently, only a few DVD players support this format.

5.4 Archiving a slideshow

Often you hawe invested a lot of time in a comprehensive and sophisticated show. As to not lose your work in
case of a hardware crash you can sawve the complete show with all containing files (images, music,
comments).

The CD/DVD and Archive Wizard offers you the opportunity to burn the complete show with all the data onto
a CD/DVD or export it to an external drive.
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This procedure is explained in the PC Show section.

5.5 Additional export options
There are other export option that you can read about in chapter Export Wizard.

6 Image editing
6.1 Integrated image editing

It is our goal to provide you with all necessary tools in one single program, the AquaSoft ® SlideShow.
Therefore we integrated image editing functionality that allows you to enhance your photos for the slideshow. Of
course there are specialized image editing applications that go far beyond the capabilities of the image editing
module in AquaSoft ® SlideShow but it should be possible to solve the most important tasks inside the
program.

Edit image effects

Rotation

El@=iB~dE—i|
|

Crop / Mirror

|-.‘—-'\$=_) Crop || ||5i(j FlipH | ||§_€* Flip ¥ | %

Exposure

||E Exposure auto correckion |

|M Histagram correction '| |! Eamma ‘| :
= |
!

Color

!

; d i I

| Calor correction | Colorize il ||
| |

!

| Reset | :

|

|

|

|

|

|

|

|

" 1|
|!H EBrightness/Contrast | Il
1|

|

|

|

|

|

|

|

|

|

|‘ Tools fEi{=e

‘ I Ok | | Cancel

Use the right mouse button to click on the image and select the option Edit image. There are functions to crop
and rotate images, for color correction, adjustment of brightness and contrast and some filters like blurring. By

using the magnifying buttons (just like in Layout Designer) you can adjust the size of the display of the image

or image segment.

None of the provided image editing functions modifies your original image.

The modification only affect the display of the images inside the slideshow.

]
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6.2 AquaSoft ® Image effects

@ The Image effect editor is only available in AquaSoft ® SlideShow Ultimate and Blue Net.

@

With Image effects graphics can be optimized or spiced up. From a simple shadow over pleasing frames and
collages to branched effect chains (Multiplicating) many things are possible. Complex effects are combined
from different basic modules and allow non-destructive image editing (the original image always stays
untouched).

When you click on an image in the Image list or Timeline you can select the menu item Edit image.

D@ &0 |

| Tools

Under Effectsthe Image effect editor opens.
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Edit image effects

ﬁ Duplizate

= ¥ Transformation
Calorize

3 [¥] Transformation

Shadaw

Taols

BB e e 8
BEE =R
» EEREEEEEE R R R AR EREEEEEE
ol shoce M — e e e e e e e e
. EEEEEEEEEEEEEEEERREEREEEEEEE
Sakuration; — 128 = :a:a:a:a:a:a:a:a:a:a:a:a:a:a:a:a a:a:a:a:a:a:a:a:a BEEE
B H B EE EE s E e e e e e s e s e e S s S EEEEEEE.
BEEEEEE
BB E =R
BB B 88

— e e e e e
||

i

With the help of the Image effect editor those effects can be assembled and saved to be reused later. Let's
just start with a shadow effect and improve our skills to create a "self-border" afterwards.
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6.2.1 Asimple shadow

You need only a few clicks to assign an unobtrusive drop shadow to an image.

DB |

Bilur

Border
Brightneszs/Contrazt
Collage

Color correction
Caolor filling

Caolotize

Cantour

Crop

Duplicate

Exposure AutoCorect
Frames

Gamma

Glow I
Hiztogram 1
ack

Mirrar

Shadow

Sharpen

Transformation

Transparency

Sub-effects are simply added \via the menu. Thus add the sub-effect "Shadow".

Note: The number of available sub-effects in your version of the application can differ from that in the image

abowe.

Now you can see that the shadow has been added to the previously empty "effect list". On the right side of the
dialog appear controls that let you adjust the settings of the shadow to your liking.
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Edit image effects

D& E a0 0 NG
| - ) e 1

Shadow
Distance:

Elur: 0,10 cm s

|

A ‘
|
m

Angle; |45,D 4 =

Transparency

w:‘ 33% [

Finished {

‘r Ok \| |r Cancel 1

At the bottom-left the shadow effect is showcased on the butterfly graphic.

Each sub-effect can have very different settings. How each of them affects the result you can find out best by
trial and error. In our specific example the offset of the shadow from the original image, the angle of the
incidence of light, the strength of the blur and the transparence of the shadow can be specified.

That's all there is to it. Clicking OK applies the shadow to your image. Of course, all the settings can still be
edited later. The original graphic is never changed.

Copyright © AquaSoft GmbH 1999-2015



140 AquaSoft SlideShow - Help

6.2.2 A"self-border" using multiplication and transformation

We want to achieve an effect that used the image itself to create a semi-transparent border. The result will look
similar to the picture below:

The basic idea of the solution looks like the following:
1. Enlarge the image and assign semi-transparency to it

2. Owerlay the semi-transparent image with the original image

Here an important functionality is utilized that is also crucial for the creation of many other complex effects:
Multiplication.

To achiewve 2. at all a copy of the original image needs to be stored to be able to owerlay the image that might
already be changed by previously assigned sub-effects. The multiplication effect allows exactly this. By using it
the normally flat list of effects will become a tree, because the multiplication effect can have child elements.
The sub-effects can be mowved around via drag&drop.

All effects that are children of the multiplication effect are "served" with that state of the image data source that
has been current at the branching point, no matter in which way and how much a different child element has
changed the image.
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Edit image effects

D& BT
= Duplicats

& O

H E Transparency

[¥] Transformation

Transformation type

|Scale

m

Zoom in/Zoom out

@] Relative Flin% Ehinem

Width: penam 1] \Fi
Height: peoem 3]

|| Finished 1

1| |: Cancel ;| ‘

Here you see the completed effect: The multiplication effect got a transformation assigned as sub-effect that
enlarges the image by a few millimeters. To that the transparency effect is assigned to make the image semi-
transparent.

Now we need to use a little trick: To display the original image again we simply add a second transformation to
the multiplication. Only this time no offset, rotation, etc. is set. So the image stays the same.

Note: Child elements of multiplication effects can have child elements themselves.
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7 Wizards
7.1 Export Wizard

The Export Wizard will assist you in burning your finished slideshows onto a CD/DVD or archiving them, or

also saving them as a video, to the hard disk.

You can access the Export Wizard via Wizards -> Export Wizard.

Export Wizard

Select an export format:

2 i &

: []
=
PCjData Print PDF

Burn COJDYD

.

Web

l!!“i - . ]

‘webShow SlideShow-Manager  Photoslbum

Cancel

Photok alender

DpeEn

m

Burn onto CD/DVD

Select this menu item if you would like to record your show onto a CD/DVD.

PC/Data

Select this option if you would like to archive your slideshow and all associated data (images, music) on the

hard disk or sawe it to the hard disk as a video.

If you would like to burn your show onto a CD/DVD, click Burn CD/DVD and then click Open (or double-click

CD/DVD).

Select an expart format:

'i' U , ;j; .-'

i

R

Yideo-SWCD Yideo-YCD
mend

Cancel

! Burn PC-slideshow Burn existing video

Yideo-DYD with

Video-DDy

open

You now have several possibilities.
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For the DVD player:
Video VCD

Creates an MPEG 1 video and burns it onto a CD as a VCD.
Resolution: 352x288

Video SVCD

Creates an MPEG 2 video and burns it onto a CD as a SVCD.
Resolution: 480x576

Video DVD

Creates an MPEG 2 video and burns it onto a DVD as a video DVD.
Resolution: 720x576

Burn a video already created

Should you already have created the video, you can, in this way, burn the video onto a CD/DVD.

You can find out whether your DVD player plays back VCD and SVCD from the operating manual.

Note:

143

If you encounter difficulties replaying a burned VCD/SVCD/DVD on a DVD-player it can help to reduce the

burning speed in the settings for the CD/DVD-burner and/or to change the brand of the CDs/DVDs.

You can find additional information in chapter DVD-player.

For the PC:
Burn a PC-slideshow:

With a PC slideshow, the images are not converted into a video. This CD/DVD can only be placed back on the
PC (Windows 2000/XP/Vista). These CDs/DVDs are also well suited to archiving a show, since all pieces of

music and images incorporated in the show are copied onto the CD/DVD.

Should you only wish to save your show on the PC, without burning it, you can open PC/data in the first step in

the Export Wizard.

Select an expart format:

e ;T J
v &
- Create viden

Archive

PC-slideshow
Deskiop Album  Deskkop Kalender  Create PC-Menu Screen Saver
(EXE) (EXE)

Cancel i Cpen

Here you have the possibility of archiving/putting together the show for the PC or converting the show into a

video. Additional information can be found in the PC Show section.

The grayed-out functions will become active only when you install other products by AquaSoft that come with
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the respective plug-in.

For output for DVD-player or for video creation it calls the Video Wizard.

@ The Export Wizard accesses the relevant wizard, according to the task selected.

For output for PC it opens then CD/DVD and Archiving Wizard.

7.2 ScreenShow Wizard

Mit diesem Assistenten kdnnen Sie lhre Show als Bildschirmschoner einrichten. Sie kénnen auch einen
Bildschirmschoner zum Weitergeben erzeugen.

= ScreenShow-Wizard x

ScreenShow-Wizard

‘With this wizard vou can create a screen saver from the current slide show for use
an your PC or distribution ko other computers,

Click "Mext" to continue,

Cancel

Geben Sie in dem Feld Titel einen Namen fiir den Bildschirmschoners ein. Wenn Sie den Bildschirmschoner
fur Inren PC erstellen, erscheint er unter dieser Bezeichnung in der Liste Ihrer installierten Bildschirmschoner.
Wird der Bildschirmschoner jedoch als Weitergabe fiir andere PCs erstellt, stellt der Titel einen Teil des

Dateinamens dar.

= ScreenShow-Wizard X

Default settings

Define the title of the screen saver here how it shall be later displayed in the list
of installed screen savers,

Title: EtI;_’Iirroring

The following settings determine the runtime behavior. ¥ou can adjust the options
later in the sceen saver settings.

[T 1Use sound

|¥] Continue screen saver at last position

|71 Play images in random order

[¥]Use Direct? player (hardware accelerated)

Defaulk duration: r3,-DDE 2

Caniel

< Back. | i Mt

Weiterhin kénnen Sie mit den Einstellungen das Abspielverhalten des Bildschirmschoners andern. Entfernen
Sie den Haken von Sound verwenden, wenn keine Sounds inklusive der Hintergrundmusik wiedergegeben
werden sollen. Ist die Option Bildschirmschoner an der letzten Position fortsetzen markiert, dann beginnt
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der Bildschirmschoner beim néchsten Start an der Stelle, wo er das letzte Mal beendet wurde. Wenn die Bilder
nicht in der urspringlichen Reihenfolge wiedergegeben werden sollen, kénnen Sie die Abspielsequenz auf
Wunsch durch Markieren der Option Bilder in zufélliger Reihenfolge wiedergeben per Zufall variieren. Mit
der Standardverweildauer legen Sie das Zeitintervall fest, in dem ein Bild erscheint. Diese Option betrifft nur
solche Bilder, welche die Standardverweildauer verwenden. Mdchten Sie beim Bildschirmschoner den DirectX-
Player verwenden, so kdnnen Sie die Option hier auswéhlen. Bitte beachten Sie dazu aber die
Systemanforderung des Players. Fir altere PCs empfiehlt sich eventuell die Option zu deaktivieren.

Mit der Wahl des Ziels legen Sie fest, ob der Bildschirmschoner auf lnrem PC installiert oder als Weitergabe fir
andere PCs erstellt werden soll.

¥ ScieenShow-Wizard x

Selection of destination

Do you want ko use the screen saver on your PC, or shall i be distributed ko
other computers?

50 Use onmy PC

7 Distribute ko other computers

Canicel | < Back | [ |

Auf meinem PC verwenden

Wenn Sie sich fur die 1. Option entscheiden, wird der Bildschirmschoner nach dem Erstellen sofort auf Inrem
PC eingerichtet. Sie missen darauf achten, dass die Diashow weder geléscht noch umbenannt wird,
ansonsten kann der Bildschirmschoner nicht mehr korrekt ausgefuihrt werden.

= ScreenShow-Wizard x

Install screen saver

The screen saver can now be installed, If the image list is nat saved yet yau'l
be asked to do so.

Mote: Later changes to the image list will influence the screen saver, Please
take care that this file will neither be renamed nor deleted.,

i Install

Caniel | < Back

Klicken Sie nun auf Installieren, um den Bildschirmschoner auf lnrem PC einzurichten. Nach dem
erfolgreichen Erstellen wird der Bildschirmschoner installiert und Sie erhalten ein Vorschau-Fenster, in dem Sie
den Bildschirmschoner testen kénnen.

Auf anderen Computern verwenden
Der ScreenShow-Assistent bietet lhnen auch die Méglichkeit Bildschirmschoner als Weitergabe fiir andere
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PCs zu erstellen. In diesem Fall wird der Bildschirmschoner nicht auf lnrem PC installiert, sondern eine Datei
mit der Endung .scr erzeugt. Hier ist Ihre Bilderliste bereits integriert, so dass Sie lediglich den
Bildschirmschoner als einzige Datei weitergeben missen.

Bewor der Bildschirmschoner erstellt werden kann, missen Sie ein Zielverzeichnis auswahlen, in dem der
Bildschirmschoner gespeichert wird. Optional haben Sie die Mdéglichkeit die Datei zu komprimieren. Markieren
Sie diese Option, wenn der Bildschirmschoner als Zip-Datei gespeichert werden soll. Auf Wunsch kénnen Sie
den erstellten Bildschirmschoner auch auf lhrem System einrichten lassen. Aktivieren Sie dazu die Option
Bildschirmschoner auf meinem PC einrichten. Die letzte Option ist jedoch nicht verfiigbar, wenn der
Bildschirmschoner komprimiert wird, da Windows keine gepackten Dateien als Bildschirmschoner verwenden
kann.

¥ ScieenShow-Wizard x

Create screen saver
The screen saver can now be created For distribution to other computers,

Please select the target directory where the sceen saver shall be saved:
[\ ScreenSavers) @I

[Tl Compress screen saver
| Setup screen saver on iy PC
[715end screen saver by email

Create

Canicel | < Back

Klicken Sie nun auf Erstellen, um den Bildschirmschoner zu erzeugen. Beim Erstellen wird die Bilderliste
integriert und es genugt den Bildschirmschoner (als einzige Datei) an Ihre Freunde und Bekannte
weiterzugeben.

7.3 SlideShow-Manager

The SlideShow-M anager allows to burn multiple shows to a CD/DVD. It creates a CD/DVD menu that allows
to navigate to a certain show.

AquaSoft ® SlideShow Ultimate and Blue Net already contains SlideShow-Manager. If you're using
SlideShow Premium and want to use SlideShow-Manager you can purchase it as a separate product.

You can find an extensive description of SlideShow-Manager in the help files of SlideShow-Manager. A
short description is included into this manual in chapter DVD-Player.

7.4 Sound Wizard

Using the Sound Wizard you can record spoken commentaries and noises with your images using a
microphone connected to the PC.

You will find the Sound Wizard in the menu under Wizards.
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1 Sound Wizard

Sound Wizard

The Sound Wizard helps you dub vour slideshow, It shows you all abjects you can
record sound to and make an easy sound recording possible, without questions
about filenames, etc.

Mote: Background music can be added through the Slideshow Settings.

Save sound in direckory;

[ Use slideshow directory

Set recording quality:

I Record settings

Click "Next" to proceed.

Cancel

You can sawe the resulting files in the slideshow directory or in a separate directory.

Under Record settings you can decide the settings with which the commentaries should be recorded.

Then click Next.

1 Sound Wizard

Ohbject: Portrait.jpg Sound;

E
Length: #

Recording device:

Hauptlautstarke (Diitale - |

é\_)—

Low Loud

! ‘ Record |

!: < Previous | | Mexk = i | Close

Cancel | < Back |

147

Now all the images in the show with which you can include a commentary will be shown to you in sequence.
To do so, simply click Record and then speak your commentary on the relevant image. Should you make a
mistake while recording, you only need to re-record the commentary for the selected image.
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1 Sound Wizard x

Ohbject: Portrait.jpg Sound;
O:l‘MEd\a‘\,‘Shnws\,sw_ﬂ[ @

Length: 0:13

Recording device:

Hauptiautstare (Digtale - |
;\_)—
T e T

Low Loud

|| ‘ Record ||

|: < Previous | | Flay | | Mexk = | | Class

| Cancel | < Back |

With Play you can listen to your recording. In order to get to the next image, click Next. Once you have
finished recording, close the Sound Wizard.

The Sound Wizard automatically matches up your images with the commentaries recorded. You can find the
recorded file in the Object settings of the relevant image. The recording can also be played back here, using

the l[ﬁj

Ub}EEtSEm’)QS =
|Object settings

button.

(¥} Shaw object

Duration: (200,51 s¢ % | Distance: 4,40 sec :-:

17| Use deFaulk duration (Settings)
Leave in place after replay

| mm Iil]l Snundl
= Sound
T OIS |
OniMedialMusich Artisti01-Title01 . wma Q =
| 7 Record | Duration: 03:19,904 ‘EH
= ¥olume
Yolume: 100% :

17| Fade hackground music (Sattings)
i= Replay behavior

Start position: D,DDS__

0 adjust display duration to sound duration

(71 Contirue sound after end of image

~1 Fade-out sound after end of image

The Sound Wizard can also be started directly from the Object settings of an image. For that there is the
Recard button.

@ The length of the image is automatically adapted to the length of the commentary.

@
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7.5 Import Wizard

With this wizard you can import your images from a scanner or from your digital camera, as long as these
devices respond to the TWAIN32 interface. The images are saved and included in the Image list. They can
either be improved with the editing function immediately or later.

You can access these under Wizards -> Import Wizard.

2 Import-Wizard X

Image settings
Director_y to save images ko
0:|MedialImages|, &)
In what Farmat do you want the images to be saved?

" Selected format:
JPEG (*.ipg; ™. jpeg)

| Farmat options.|

i Y
| Truetision Targa (*.tga)
‘Windows Bitmaps (*.bmp)

Some image Formats have additional settings, lilke
compression ekc. You can change these settings in
| Format Cptions.
| &dd images ta slide show
™| Confirm automatically

i_ Select scannerfcamera

Click "Mext" to proceed.

Cancel < Back | |‘ et = |

Specify a Target directory in which the images should be saved. Selected the desired file format and, if
necessary, adjust the Format options.

If the images are supposed to be directly included in the Image list of the slideshow, enable this function.
Then select the scanner or camera.

Next click Next and then click Start. Your images are now imported.

7.6 PowerPoint Wizard

With the PowerPoint Wizard you can import your PowerPoint presentations into the slideshow. A prerequisite
is that MS PowerPoint (Version 8 or later) is installed on your PC.

During import the individual slides are saved as images. All animations and effects will be lost in the process,
howe\er.

You can start these under Wizards -> PowerPoint Wizard.
Specify the File nam e of the PowerPoint file to be imported.
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1 PowerPoint-Wizard

Cancel

PowerPoint-\Wizard

This wizard allows wou to import 15 PowerPoint Files (*.PPT) inta SlideShow.
Each slide will be saved as animage {animations etc. will be lost).

Wou must have M3 PowerPoint (version & or higher) installed because SlideShow
cannot read the files directly, After importing MS PowerPoint is not needed again.

File: name: of the PowerPoint-file you wank to import:

O:\PPTIPRT.ppt =

Click "Next" to proceed.

Then click Next.

Specify a Directory in which the images should be saved. You can use the slide name as the file name or use
the form Im agexxx.

1 PowerPoint-Wizard

Cancel

File settings

The PowerPaint-slides will be saved as image files. Please enter the name and folder
b0 save the files,

Target directory:

(0P} =)

Find file names:
170 Use PowerPaint siide name

71 Use names in the Form “Imagesse:

Click "Next" to proceed.

< Back: | |‘ Next > |

Click Next.

Now you can set the image options. Select the desired resolution and the image format. Under Form at

options you can configure additional settings relating to the image format.
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1 PowerPoint-Wizard

Image settings

In what resolution do you want to save the slides?

1 540x480 1 Cuskom resolution:

) BODXE00 Width: te0n %]
7 1024768

: Heighit: 14
) 11525864 : tz00 (2]
1 1280x1024

0 1e00xizon V] Antialiasing

In which Format do you want to save the images?
EGF"- 'ﬂﬂ‘.’ "3’ ) Selected format:

| Truelision Targa (*.tgal e
|wWindaws Bitraps (*.bmp) IPEG (*.jpg;*.jpeg)

|. Farmat opticons |

Click "Next" to proceed.

| Cancel < Back | |‘ MNext =

Click Next and then click Import. The slides are now converted into image files and inserted into your
slideshow.

7.7 Video Wizard

In order to show your show on the television, you can create a CD/DVD for the DVD player with the Video
Wizard. You can access this under Wizards -> Video Wizard.

An exact description of the wizard can be found in the DVD Player section.

7.8 CD/DVD- and Archiving Wizard

The CD/DVD and Archiving Wizard will be explained extensively in chapter PC-Show.
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7.9 Photo Frame Wizard

Using the Photo Frame Wizard you can transmit your slideshows as individual images or as a complete video
on a digital photo frame.

1 Photo Frame-Wizard

Cancel

Photo Frame-Wizard

The PhotoFrame-Wizard allows you to transfer your sideshow to a digital phota
Framie.
How do wou want to transfer the show?

(7 Transfer separate images

Adjusts all images to the size of you photo frame and transfers them. Captions
remain intact, but animations and transitions do niok,

" Transfer slideshow as video
If you Frame suppoarts videos yau can use this option to convert the slideshow

into a video (MIPEG) and to transfer it to the frame, The slideshow will be
replayed on the frame including sound, music and all animations.

Export as separate images

Firstly, specify the resolution of your frame. If you are not sure what resolution your device has, you will
generally find details in the corresponding manual or on the manufacturer's web site.

2 Photo Frame-Wizard

Cancel

Resolution

Which resolution does your phota frame have?

20 Pre-defined resolution:

[1024 x 600 3
() Custom resolution:

|0 )l =% o Al

If wou are uncertain which aspect ratio is supported by your photo frame, please
consult its user manual,

« Back | |‘ fext =

Text can be included with your images, text animations will be dropped, though. The text becomes a static part

of the image.

If your images have a different aspect ratio than your photo frame you can use the option Crop images to
display them full frame.
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11 Photo Frame-Wizard x

Photo Frame-Wizard

Please select how the wizard shall process your photos,
¥ Assume image captions
I you specified captions for your images the captions will stay inkact,

Images that don't completely fitinto the Frame will be crapped to become Format
Filling.

[T liCrop images

Image qualicy: 90 % :4

The higher the quality is the higher are the space requirements.

| Cancel < Back: | |‘ Next > |

In the last step select the storage location for your images. This can be the photo frame, a USB stick or a
memory card.

Click Start. The wizard now computes your images in accordance with the predetermined settings and copies
them into the target directory.

11 Photo Frame-Wizard x

Transfer

There are different options to transfer the slideshow ta the frame.

+ per USB: Directly connect the frame to your PC using a USE cable. The Frame
will get its own drive letter assigned. Select it in the field below,

+ per memory card/USB stick: If your frame has a plugin position For a
memary card {g.3. S0 or CF card) or a USE stick then plug one of those into vour
PC. You might need & separate card reader For memary cards, Select the drive
letter of the card or the stickin the field balow,

Target {memary card or frame):

I shows) E|

| Cancel | < Back |

Transmitting a slide show as avideo

If you want to transfer the whole show as a video please verify beforehand that your photo frame supports
Motion JPEG videos.
This information should be provided in the manual of the photo frame.
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11 Photo Frame-Wizard x

Resolution

wWyhich resolution does your photo frame have?
0 Pre-defined resolution:

[1024 x 600 -
71 Custorn resolution:

1480 Jall ow {2ss
E‘Iaase note the supparted video resolution can differ from the resalution of the
rame.

If wou are uncertain which aspect ratio is supparted by vour phota frame, please
consulk its user manual.

Cancel < Back: | |‘ Next > |

In case your show has a different resolution than your photo frame you can now activate the option to correct
the aspect ratio and fill the remaining borders with black. This way the images won't get distorted. You can
also decide to integrate sound and music into the video, which only makes sense if your photo frame is able to
replay them.

11 Photo Frame-Wizard x
Video Format

The wizard can process the photos in different ways.

|| Carrect aspect ratio with colored barders:

If the video doesn't fill the Farmat if your frame black barders will be added, so
that the video won't get stretched unproportionally,

|9 Integrate sound and music

Hink: Without sound the video will use less space.
Image quality; 90% [T

The higher the quality is the higher are the space requirements.

Cancel < Back | | et =

In the last step select the storage location for the video. This can be the photo frame, a USB stick or a memory
card.

7.10 PSP Wizard

To transfer the slideshow to your Playstation Portable please follow the next steps.

Connect the PSP to your PC

Use the USB cable that came with your PSP to connect it with your computer. In the menu of the PSP go to
the Settings menu and select the entry USB connection using the arrow keys, and then hit press the X key of
the PSP. As soon as USB mode is displayed the PSP is connected to your computer.
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Start the PSP-Video-Wizard

If you haven't done yet please open the slideshow you want to transfer with AquaSoft ® SlideShow. Then select
the menu item Wizards -> PSP Wizard to open the dialog for the transfer to your Playstation Portable.

I Transfer zlideshow to Playstation Portable [F5F] X

PSP Wizard
Yideo:

Resolution: |43 Best quaiity faén xé40} - | [ Restrict size

Size! 16,1 ME

EEP SRR

Click "Mext” bo set the slideshow title,

Cancel

As long as the PSP is not correctly connected to your computer this state is displayed

f\\ Mo PSP connecked,

On the first page of the wizard you have the option to choose from different resolutions. Since the display of the
PSP has a 16:9 format you can choose this option to create screen-filling videos. Limit the size of the video if
your PSP doesn't have enough memory available. The smaller the file size of the video the lower the video
quality will be.

Then click Nextto reach the next page of the wizard.

Specify the title of the video and a preview image

Provide a meaningful title for your video on the next page so that it can be found quickly. It will appear, together
with the preview image, on the video list of your Playstation Portable after the transfer.
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1 Transfer slideshow to Playstation Portable [PSP) x

Enter kitle

Enter the Litle for vour slideshow here.

The title will be shown on the PSP and will make it easy for vou ta quickly find your
videa,

vacation 2010

Select thumbnail

Select an image here that is bo be shown as a
thurbnail For the created video on vour PSP,

- Should vou change your mind, you can remave
the: thumbnail here,

Click "Mext” to create the videa,

Cancel < Back: | |f Next > |

You're done

Please wait while the slideshow for your PSP is being created. Depending on its size this process can take
several minutes. Afterwards the video will be transferred to your PSP at once. Now present your slideshow -
whenever, where ever.

If your PSP is not connected to your PC you can store the \video file after its creation on your
computer. So you can transfer the video yourself to your PSP at a later time.

7.11 iPod Wizard

To transfer the slideshow to your Apple iPod please follow the next steps.

Connect the iPod to your PC

Use the USB cable that came with your iPod to connect it with your computer. As soon as the message
"Don't disconnect" appears the iPod is connected with your computer. In addition you need to install the
software iTunes on your PC to be able to transfer the video. If you haven't done so already please download this
free software from this Internet address http://www.apple.com/itunes/download/ .

Start the iPod-Video-Wizard

If you haven't done yet please open the slideshow you want to transfer with AquaSoft ® SlideShow. Then select
the menu item Wizards -> iPod Wizard to open the dialog for the transfer to your iPod.
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1 Transfer slideshow to iPod

Yideo:

iPod Wizard

Size: |10.1 ME:

Cancel

Reszolution; .4_3 highest: quality (540 < 480)

Click "Next" to set the slideshow fitle.

i - || Restict size

U

As long as the iPod is not correctly connected to your computer this state is displayed

f\\ Mo iPod connected,
-

On the first page of the wizard you have the option to choose between the default 4:3 or a user-defined
resolution. Limit the size of the video if your iPod doesn't have enough memory available. The smaller the file

size of the video the lower the video quality will be.

Then click Nextto reach the next page of the wizard.

Specify the title of the video

Provide a meaningful title for your video on the next page so that it can be found quickly. It will appear on the

video list of your iPod after the transfer.

I Transfer slideshow to iPod

Enter title

Enter the title of your slideshow here.

[Vacation 2010

The title will be shown on the iPod 20 you can find your video quickly

Click "Next" to create the video.

Cancel

< Back

Next »

You're done

Please wait while the slideshow for your iPod is being created. Depending on its size this process can take
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seweral minutes. Afterwards the video will be transferred to your iPod at once. Now present your slideshow -
whenever, where ever.

If your iPod is not connected to your PC you can store the video file after its creation on your
computer. So you can transfer the video yourself to your iPod at a later time.

e

7.12 Mobile Wizard

To transfer the slideshow to your mobile phone or PDA please follow the next steps.

Configuring your Bluetooth device on your PC

If you want to connect your device via Bluetooth with your computer you have to configure the mobile device on
your PC once. To do that go to Windows Start menu and click Control Panel -> Bluetooth Devices. Now
the Bluetooth Device Dialog appears. Press Add Wireless Device... to execute the Bluetooth Wizard. After a
successful configuration your device is ready for Bluetooth transfer.

Bluetaoth Devices

Name’ Dewvice Category
B Mokiaszo

B Bluetaoth

FKathy (work)
Bluetooth

Mokia 5230 Discovery Method: Bluetooth Address: c8:97:9f:bd:ad:6a
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@ If you connect your mobile device via Infrared or cable you can skip this step.

@

Start the Mobile Wizard

If you haven't done yet please open the slideshow you want to transfer with AquaSoft ® SlideShow. Then select
the menu item Wizards -> Mobile Wizard to open the dialog for the transfer to your mobile device. Select the
radio button Use current slideshow for my mobile device to transfer the current slideshow.

11 Mobile Wizard

Mobile Wizard

“wiith the help of Mobile ‘Wizard you can present your slideshows on many mobile:
devices.

After you zelected your target device the video will be transferred to your mobile phone
or PDA via Bluetooth, Infrared or cable.
What do you want to do next?

= |Jse current slideshow for my mobile device

171 Select egisting viden

Click "Mext" to continue.

Cancel

Select your device

On the following page you select the target device. You can create videos for your mobile phone or your PDA. If
you cannot find a suitable profile you can configure the settings manually. Then click Nextto create the video.

11 Mobile Wizard

Please select your device
Mobile Phote -]

Device:

Frofile: | Profile 3 [H 263/4MF - 176 » 144 pisels) B

E stimated file size: 503,42 KB

| case there izn't a profile listed that fitz pour needs vou can change the settings
manualy.

Click "Mest" to create the video.

< Back

Cancel

Hext »

2

Before you change the settings manually please consult the user manual for your device to learn
which video options your device supports. Important are especially the video resolution, as well as
the supported video formats. Experiment a little with the settings to find the best possible
configuration. Typical video resolutions for mobile phones are 176x144 pixels and 128x96 pixels.
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Specify the title of the video

Provide a meaningful title for your video on the next page so that it can be found quickly. It will appear on the
video list of your mobile device after the transfer.

I Mobile Wizard

Trangfer wvideo to your mobile device

Define the file hame that your file will appear under on vour target device, Do
not type a file extenzion to select an appropriate extenzion automatically.

File name: [Wacation 2010

Information about video

File size: EGE.42 KB

Click "Nest'"to select the target device.

Cancel

< Back | |‘ HNext > |

Transfer the video to your mobile device

The video is now ready to be transferred to your mobile device. You have the option to transfer it via Bluetooth,

Infrared or USB cable. Please create a connection to your phone or PDA. Click Search for devicesto
determine all devices connected to your PC.

Devices connected to your PC

Kathyfwork] . MokiaB230 [ Savelo harddisk

Search for devices

Select the device that you want pour video to be transferred ta. Click the on "Mest'.

I Cancel < Back | |‘ Meut » i

Wireless transfer via Bluetooth/Infrared

You need a Bluetooth/Infrared receiver in your PC for wireless transfer. These interfaces are mostly in place in

modern Notebooks, but if they aren't you can upgrade your computer for only a little money. Usually these
devices are offered as small USB sticks.

Follow these steps to transfer the video to your mobile device wirelessly:

1. Activate Bluetooth or Infrared on your mobile device as well as on your PC. When using Bluetooth you
have to register your device on your PC once (see first paragraph of this chapter)
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2. If the devices are in close enough distance to each other the connection will be created automatically. If
you're using Infrared the emitters need to "see" each other. With Bluetooth it is sufficient for your mobile
phone/PDA to be in the same room as your PC.

3. Your device should appear in the list of detected devices. If you start the video transfer via the wizard
you'll to accept the video file on your mobile device to allow the transfer.

4. After the transfer was successful the video is located on your mobile phone/PDA and you can replay it.

Transfer via USB cable
Prerequisite for a transfer via USB cable is the recognition of your device as removable medium. Please consult
the user manual of the device to see if this feature is supported.

1. Connect your device to the PC using the USB cable.

2. The device should now be recognized as removable medium.

3. In the Mobile Wizard select the option Save to disk.

4. As target drive you select the drive letter that has been assigned to your device. Possibly you have to
sawve the video to a certain folder. Please consult the user manual of your device.

Transfer using the software of your mobile device

A transfer of the video by using the software provided with your mobile phone/PDA is to be taken into
consideration if you cannot transfer it wireless nor via USB cable with the wizard. At first save the video with the
option Save to disk. Then launch your mobile phone/PDA software to transfer the newly created video to your
device.

the supported formats. If you encounter difficulties replaying the video your device doesn't support

|@ Not every mobile device can replay all video formats. The user manual of your device usually lists
its format. In this case use a different profile for the video creation and transfer the video once more.

@

If the transfer with the wizard doesn't work please use the transfer software that came with your
device. In any case: Please consult the user manual of your mobile device. Every mobile phone/
PDA is different and needs to be handled differently.

You're done

The video is now stored on your mobile device. In the last step of the wizard you have option to transfer the
video to a different device or to sawe it to your hard drive. Select the option End wizard to finalize the process.

The wizard was successfully executed

The video was successhully transferned to your mobile device. Please decide with
which step you wish to continue.

& End wizard
7 Transter video to a different mobile device

(71 Save copy.of video on my hard disk

I Cancel < Back | Hew:

Copyright © AquaSoft GmbH 1999-2015



162 AquaSoft SlideShow - Help

7.13 Find missing files

AquaSoft ® SlideShow only sawes links to your images and music which you use in the slideshow. Should
you mowe, delete or rename your images. AquaSoft ® SlideShow can no longer access them. You will then
see the following notice in the Layout Designer.

t be Found
"Find

AquaSoft ® SlideShow cannot retrieve/recover deleted images.
Under Wizards -> Find files you can call the Search Path Wizard.

1 Change Search Path X

Search for missing files
In case you maved of renamed your files; and Slideshow cannat find them anymore,
enter the new search path here:
(0 Find missing or renamed Files automatically
(71 Enter new search path directly
"I Convert absolube paths inko relative paths

1 Convert relative paths into absolute paths

Apply action to
0 Adjust selected entrizs only
"1 Adjust all entries

* Adjust background music (Slideshow settings)

Cancel

Here you have sewveral search possibilities.
If you are not sure where the files sought are located now, activate the automatic search.
If you know exactly in which directory your images are located, you can also directly specify the path.

If you want to convert the path from absolute (details of paths are saved in their entirety) to relative (details of
paths are saved in relation to the location of the ADS file) or Vice versa, select the relevant option.

Then specify the entries that should be adapted.
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Click Next.

Now select where your images should be sought.

1 Change Search Path X

Folder selection

Select Folders to be searched For missing Files,

iy Vista (C2)
@O % HD DVD-ROM-Laufwerk (D) Virtual CloneDrive
= g Misc(En)
= O B Music {F:)
i [ Gfx (G
- [ ) HD DVD-RAM-Laufwerk (H:) AQUASOFT
(— Coding (01}

Cancel < Back: | |r Next > |

Click Next and the search starts. Afterwards the results of the search are shown to you.

1 Change Search Path X

Select Fram the list of Found Files those files that are ta be assigned ko the missing
files of the slideshow.
= [# img_1930704.3pa
o O1\Media\Images\mg_1930704.jpg

Cancel < Back: | |r Einish |

Click Finish and your slideshow is updated.

8 Variables

In AquaSoft ® SlideShow there is the possibility of having certain image information displayed as a text in
the image, e.g. the date taken, the file name or the path to the image. This occurs by means of Variables.

These have to be specified in the format below in the Text field in the Object settings of an image:
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Ohject Settings

|Dbject settings
[#! Shoiw object
Duration: 5,00 sec * |

[¥] Use default duration {Settings)
¥ Leave in place after replay

T o

=/ Font

] Arial  ACHEfGH] 5

[=] Style Alignment

AlA =

[~} Text

| a’oFilename%l

[= Effect

A E'!D S Border colar:

Anirnmation:

{

{Alphablending - |_| T Edit 1|
__ Raotation around bext _ Show text with image
[ center ]

St T
Ty el path

& |

In principle, Variables have to be enclosed between two % signs.

In the Layout Designer you will then see the implementation of the Variables.

2 B B % P T 0

EXIF inform ation on your images can also be included using Variables. In that respect, your image must
contain EXIF data.
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You can check this by clicking on an image and then having the m eta-data displayed under View -> Controls.
Should these be empty, your image does not contain this data.

You will find a list of all possible Variablesin the program under Tools -> Program settings -> Plug-ins.

Program settings x
5 "
i Flug-ins =
i Add files

Plug-in management
User interface

Temporary Folder The list shows all available plug-ins. The plug-ins to be loaded are checked.

- Language Plug-n File name State
Auto update [¥] DemaPlugin.plg C:\Program Files\AquaSoft|DiaShaw ... 0K
Record sound [¥] DiaShowManager.plg C:iProgram Files\AquaSoft|DiaShow ... OK
Sound system ScreenshowPlugin.plg C:lProgram FilesiaguasoftiDiashow ... OK

< Confirmations
- CO{DYD Burner
i Autosave
= Panels
Storyboard
Layout Designer
Timeline
Imagelist

Mote: Changed plug-in settings will became active only after
the application has been restarted. | Info about plig-ins i

|| Ok | L Cancel \| |! Help !|

After clicking the Info about plug-ins button a window is opened, in which the Variables are listed.

Info: about plug-ins x
I‘v‘ariables available:l *

=370

mendseitenanzahl
mendseitenne
kapitelseitenanzahl
kapitelseitennr
menupagecount
Mmenupagent
chapterpagacount
chapterpagenr
kapitelposition

chapterposition
text D
keywards

stichworte
position
captureyear -

|! Close !|

You have to scroll down a bit in order to get to the list with the Variables.
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9 Settings
9.1 View settings

In SlideShow you can choose from different pre-defined views on the main toolbar an under View. If you want to
add other modules to the current view you can select from the menu under View -> Controls.

Please have a look at our screencast to learn how to create your own favorite layout. The screencast is
available at the following web address:

http://aquasoft.de/download/flash/edit view cast/ansicht_editieren.html

In AquaSoft ® SlideShow Ultimate and Blue Net you can sawe your layouts under View -> View
management.

9.2 Slideshow settings

The slideshow settings can be individually changed for each slideshow.
Under Slideshow -> Settings you can access the window for the Slideshow settings. You can also access

9

the settings directly via the button in the menu bar.

Basic settings:

Slideshow settings X

£l Slideshow
: Mair settings |
Slideshow flow = Display

End of slideshow

I Main settings.

A low replay quality can help speed up the slideshow on a slow computer.

Tranzitions
Music settings — "
Background music Replay quaity: | Optimurn |
Description A slideshow can be plaped in any resclution. Only the proportions are important. They
£ Logo can vary with the purpose of the slideshow.
B SlideshowFlapet Aspect ratio: I-‘I éS[DVD wide screen mon‘i;o‘r-] -

Software Player

Standard Player [Di... i alideShiont il afidestiow:flaves

Select the SlideShow-Player ta use for playing the slideshiow:

iSﬂtarncilan:Ir Player [Direct+) ',l | Configure plaper

‘i_l| oK | | LCancel | | Help

Here you can change the Standard exposure tim e of your images, as well as select a Random playback
sequence for your images.

You can adjust the "display quality" according to the performance of your computer here. The higher the quality
the higher is the required performance. This setting is of no importance during the creation of the video. It
concerns the quality when replaying the show using the AquaSoft ® SlideShow Player. If the "display
quality” is too high for your PC this can lead to a jerky replay experience of your show.

You can likewise set the Aspect ratio of your show here. Should this not correspond to the aspect ratio of your
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images, you will get edges or you fit your images into the desired aspect ratio.

Under SlideShow Player you can choose between the Software Player and the Standard Player (DirectX).
For the Standard Player (DirectX) a DirectX 9c-compatible graphics card with at least 64 MB memory is
required. It is also mandatory that you use the manufacturer's current graphics card driver!

If you still have an older graphics card or one with little memory please use the Software Player. If your show
is set to use the Standard Player (DirectX) it will be checked if it is possible to use it with your graphics card
before playing the show. If this isn't the case the Software Player is used automatically.

The Standard Player (DirectX)is considerably more powerful than the Software Player, however a
corresponding graphics card is required.

You will find settings for the corresponding SlideShow Player further on in this section.

Slideshow flow:

Slideshow settings X

B Sliae.s.hnw
UL s

Slideshow flow

2 Slideshow flow

End of slideshow - e

Fhapinme Crefault duration: \?_,DU ser C |

Music settings § . :

Bsckiroond s I | Play images in random order
Description

1 Loga

) SlideShow-Player
Software Player
Standard Player [Di...

‘E| I ok | | LCancel | |. Help

Here you can change the Default duration of your images, as well as select to Play images in random
order.

Slideshow end:
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Slideshow settings

= Sideshow
: Main settings
- Slideshow flow

Tranzitions

Music settings
- Backaround music
Description
= Logo
£ SlideShowFlayer
- Software Player

4

Standard Player [Di... |

End of slideshow

End of slideshow

Wwihen the dideshow nns thiough entirely, there are several choices .

20 Repeat curent slideshow
() End now

(71 azk user what to do

ok | |, Cancel

Here you can decide what is supposed to happen at the end of the slideshow played back. Do you want the
show repeat itself or stop after the first run? You can also let the viewer decide.

Transitions:

Slideshow settings

1 Slideshow
: b ain settings
- Slideshow flow
End of slideshow

Music settings
- Background music
Description
1 Loga
B SlideShowPlayer
- Software Player

4

Standard Player [Di...

(= Transitions

(7] Activate transitions

=l Random transition

IF pou select "Random rarsitions", anly the transitions checked here will be included in the

zelection.

Alphablending

Alphablending [plazma)
[¥] lphablending [star]
Ao
Basket
Bllindz
Elob
Bow
Bubbles
Buddha
Cels 1
Cells 2
Cells 3
Circles
Circles [getting bigger)
Circles [getting smaller)
Cross pattern
i

.
I Alphablending [gradient] % | i

ok | |, LCancel

Here you can select which transitions are supposed to be included in the Random transition. All those with

green check marks are included, all those with a red cross are not included.

Music settings:

The music settings are explained in further detail here.

Background music:
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The topic of background music is dealt with in detail here.

Description:

Slideshow settings

X
b ain settings

- Slideshow flow = Description
- End of slideshow o 3
Enter a meaninghul title and descnption far your shideshaw. This information will be used in the

Transitions SlideShow-Manager, for esample.

Music settings
Title: Thurnbnaik

: | |
Logo Author. Click here to select an image.

Bl SlideShowrFlayer | | This image will be saved
- Software Plaper Description: within the shideshow file.

Standard Player [Di...

Background music

Click right to remave the
thurnbhail.

=l Copyright

Enter the copyight information for your slideshow or images. This will be shown in the "&bout
dialog box of the SlideShow-Player.

{E| 5 ok | |, LCancel .| || Help !

You can individually personalize your show. Here you can specify a title, author and a description of your show.

Logo:

Slideshow settings X

B= S IIdEShDW
: ain settings

- Slideshow flow =l Logo at start of slideshow

- End of slideshow =
Transitions 2 Show default loga

Music settings 071 Don't show laga

Backaround music:

- Description

071 Show custan logo

i |magefileriam 55’
£ SlideShowrPlayer

- Software Player i i)

Standard Player [Di... | [#] Show loga even if slideshow is started by the main program

Minimal pauge:

1] Only as lang as intializing takes

Mote: Wwith the IntelliLoad process, SlideShow needs some time to prepare the first images: &
lnga shortens the wait for the viewer. [h case the preparation takes longer than the time pou set
far the loga it will automatically show longer.

Al

ok | |. Cancel .| || Help ||

If you want to start your show with a Logo you can select and image here. You can also simply omit a logo.

Standard player:
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Slideshow settings X

= Slideshow = A= T
7 ) Standard Player (DirectX)
H Main settings = I
Slideshow flow e
; I~ Display
End of slideshow R -
Transitions 20 Full screen I”] Change graphic mods
Music seitings ) Window mode (0] s B =l
Background music e :
Description Antisliasing: {Mone -]
H Loge Navigation I}ar Eont_rnl_
=) SlideShaw-Player ~ — = 4 - )
Software Player |¥| Forward/Back. automatic fade-in and fade- = || Forward/back per mouse click
simdﬂldPLi’;“‘I [DL. 9] Play/Pauss Visbile At ska |7 Start paused
V| Volume ¥| Place over image
%] Catalog
= IntelliLoad

SlideShow works with an inteligent preloading procedure that optimizes pauses during the
presentation by laading the nest images.

Time, which InteliLoad will preload: M0sec 2

[ lgnore InteliLoad at start

‘E| ok | | Cancel | | Help

The AquaSoft SlideShow Player takes on the task of playing back a slideshow. Here you can decide the
settings for it. First check which SlideShow Player you are using. You will see this in the Basic settings.

Select here if you want the show to be replayed in full screen or window mode.

Use the settings for Antialiasing to remove ugly artefacts at the edges. The best way to recognize the
difference is by rotating a black square in front of a white background and closely watching the edges. If the
option is set to Autom atic the level with the highest possible quality will be used. The other option cause
2X,4x,8x,16x oversampling of the image, with correspondingly increasing effort. This requires a lot of computing
power of the graphics board and can lead to jerkiness at high resolutions and older and cheaper boards.
Nonetheless, the gain of quality is, depending on the displayed contents, remarkable. Older graphic boards
should be used with the option None.

You can also specify the setting for the Navigation bar, i.e., how and when you want it to be displayed.

Under Control you can select if you want the show to be started automatically after clicking Play or if you want
it to wait for an input, i.e., if you want manually control your show. You can also activate the option to control
the image change with the mouse.

The IntelliLoad specifies how many seconds of the show should be loaded in advance.

If you want to use the selected settings as default for every new slideshow then click As default. These
settings will then be automatically assigned to all future shows. By clicking the button Original settings you
can reset all settings to the factory values.
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9.3 Music settings

You can reach the music settings via Slideshow -> Settings -> Music settings.

Slideshow settings

.:j Slldeshnw Milsi'c-seﬁings
H b ain settings
Slideshow flow = General
End of slideshow -
Transitions [¥] Activate background music

Music settings

[ Automatically repeat title list
Background music
i= ¥olume of background music

Description
1 Loga Standard volume: ,1_00___,:
B ideshaiy Playel 1= Fade-out of background music to slideshow
Software Player e

Standard Player [Di.. I= Fade music when sounds are playing

Fade wilurne:
|7 Fade sounds too

= Synchronization

S Edittitle fist

Fade-out duration: 2008 ® |

These settings apply when a sound object controls the fade-out of background music.

Fade duratior: }DED ] 5

[ Sunchronize backaround music with sideshow

Mote: Synchronizing the background music with the slideshow results in limited navigation. The
music will be stopped during jurmps or manual image movement [back/next)

‘E| K

LCancel | | Help

The Music settings can be set as desired for each show. The standard settings are illustrated.

[V] Activate background music l

[V] Autamatically repeat playlist l

! T3 Edit tite it |

Standard volume:  [100% 3 | l

Fade-out duration: IED_DTSEC _:l l

[¥] Fade-out of background music to gide show end

Fade wolume:

You decide here whether background music is supposed
to be included in your slideshow or not.

In the Background music menu you can insert several

tracks to provide background music for your show. Here
you can decide whether this list should be repeated if all
tracks have been played and the slideshow has not yet

come to an end.

Via this button you can access the Background music
menu and can remowve or insert tracks there.

Here you can set at what wolume the tracks should be
played back (100% = full volume).

Here you can specify the length of the fading out.

The background music can be gently faded out towards
the end of the slideshow or simply broken off.

If you use Sound objects or have recorded commentaries
for your images in your show, it is expedient to fade out
the background music when playing back these objects.
Specify here to what volume the sound should be faded
out.

0% = Fade out completely
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100% = Do not fade

Eodedlirabiar ;ij:'Tj — ; l Determines over what period of time the music should be
—_— faded.
[] Fade sounds too l Here you can specify whether the background music
should also be faded with included Sound objects.

[7] Synchronize background music with slide shn:nwl

If you use breaks and continue manually during the show,

you can decide whether the music should also be
interrupted during an image break, or whether it should
continue. If a check mark is placed, the music stops
during a break.

9.4 Program settings

The Program settings refer to the basic settings of the program and not to the individual settings for your
slideshow. For the slideshow created by you, the slideshow settings are decisive.

Under Extras -> Program settings you can access the program settings.

Plugins:

Program settings

9 Main setkings
|
Add files
User interface
Temporary Folder
- Language
Auto update
Record sound
Sound syskem
Confirmations
- COYDVD Burner
i Autosave
= Panels
- Storyboard
Layout Designer
Timeline
Imagelist

X

Plug-in management

The list shows all available plug-ins. The plug-ins to be loaded are checked.

Flug-in File name State
[¥] pemaPlugin.plg C:\Program Files\aquaSoftiDiaShow ... CK
[¥] DiashowManaget.plg Ci\Program FileshaguasoftiDiashow ... 0K
[¥] Screenshowrluginplg C:iProgram Files\aquaSaftiDiaShow .., CK

Moke: Changed plug-in settings will become active only after o
the application has been restarted. pifsahotE sy |

oK | ‘! Cancel | |! Help |

Contains a list of all plug-ins additionally installed which have been installed by additional AquaSoft

applications.

Add files:
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Program settings

[Main setki
i ltalnvseings Add files
¢ - Plug-ins

Whenever you add files (images, sounds, videos) the Following settings apply.

- User interface

Temparary Folder 1=l Sort
‘Language IF more than one File is ko be added simultaneausky, the list can be sorted in advance.
Auto update
- Recard sound Sort: by |Filenarne nurbering with directory {ascending) -

Sound system

=

< Confirmations i fnseetak

- CO{DYD Burner 0 Add files after selected object

i Altasave 71 Add Files at last position of slideshow
= Panels
Storyboard = Dbject types

Layout Designer IF there is more than one object type that supparts a certain file format, you can choose here

Timeline which bype should be used,

Imagelist Images Sounids Videos

{Image - iSound - Wideo -
|| Ok !| ‘| Cancel ‘| || Help ||

Here you can determine how files are supposed to be inserted into a slideshow and how they should be

arranged in this slideshow.

User interface:

Program settings
B Main settings User interface
: Plug-ins

Add files

= User interface

When v double-click on an ohject in the timeline, the object lisk, o the catalog, you can
choose a number of actions, Select here:which ones they are.

- Language
Auto update Action at double-click: !Original wiE > I
- Record sound
Sound system i= Synchronize controls
~ Confirmations [#|Synchronize cortrols

- COyDVD By i "
d bk Wwhen the controls are synchronized, the same sector of the slideshow will be shown in the

§ Autosave timeline, object list, and catalog,
= Panels

- Storyboard
Layout Designer
Timeling
Imagelist

| Ok !| ‘| Cancel ‘| || Help

Here you will find additional setting options for the user interface of AquaSoft ® SlideShow.

Temporary directory:
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Program settings

Tempurary folder

|

() Main settings

Flug-ins
Add files Temporary folder
User interface
e whenever the application needs memaory space o your hard drive For a short time, it nesds a
Ll termporary folder. The standard is to use the one in the Windows directory. But for certain
- Language tasks the required space can become rather large. If the Windows-Temp-Folder doesn't offer
Auks update enough disk space you can specify a different one here.

Record sound [¥] Use windows' terparary directary

Sound system

< Confirmations Tempo; \der:
- CO{DYD Burner m
i Autosave

= Panels
Storyboard
Layout Designer
Timeline
Imagelist

| Ok | ‘| Cancel ‘| || Help ||

AquaSoft ® SlideShow from time to time requires temporary disk space on the hard disk. Here you can
specify in which directory temporary files may be buffered. A lot off memory is necessary during video cretion. If
the Temp directory doesn't provide enough space you can specify another directory here.

Language:

Program settings

X
= Main sekt ]
) Main settings Language
: Plug-ins
i Add files

User interface
Temporary Folder

Language

Please select the language you would like the praogram ko use.
The language setting will also effect the SlideShave-Plaver when vou create slideshow CDs
with the €0 Yizard,

Auto update

Record sound IR

|Deutsch | German

Sound system
+ Confirmations
- COfDVD Burner
Autosave

= Panels
- Storyboard
Layout Designer
Timeling
Imagelist

|| Ok | ‘| Cancel ‘| || Help ||

AquaSoft ® SlideShow supports several languages, which you can change here.

Automatic update:
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Program settings

|

= Mai tLi
Bl se. ngs Aute update
: Flug-ins

Add files =l Automatic update check

User interface
The automatic update check searches ragularky For rew versions of your software on the

Temporary folder internet. You will be notified if there are updates,

- Language
‘Auto update || Activate automatic update check

Record sound —

Check f| | S| D
Sound system ER every [—'l i
< Confirmations

- CO{DYD Burner
Autosave

= Panels
Storyboard
Layout Designer
Timeline
Imagelist

|| Ok | ‘| Cancel ‘| || Help i

Here you can set the intervals at which AquaSoft ® SlideShow is supposed to check for updates. This way
you stay up to date So bleiben Sie immer auf dem aktuellsten Stand. Zur Priifung wird eine Verbindung zum

Internet benétigt.

Record sound:

Program settings

X
= Main setti ]
Lj oy
H Plug-ins

Add files
Vi e Choose the settings to record sounds. Recommended settings For recording speech: 44100
Hz, 16 Bit, Mono
Temporary Folder
=l Sample rate
- Language ————e
Auto update 71 11025Hz () Othets: Fﬂﬁ Hz :_| The higher the values you specify,
P e e the better the recording quality.
S, 71 22050 Hz ‘with rising qualicy, the memary
Sound system ) . space needed increases.
- Confirmations ) 44100 Hz
- COfDVD Burner 1 48000 Hz
i Autosave
e i=l Channels =l Sample size
= Panels ——— =
- Storyboard 0 Mario Maote that & microphone only 1 & Eit
L t Desi - sends a mono signal. Choosing -
YL (%) Sterea sheren uses double memary 0 16 Bik
Timeling space unnecessarily .
Imagelist
|| Ok | ‘| Cancel ‘| || Help ||

Using the Sound Wizard you can record spoken commentaries with your images by means of a microphone
connected to your PC. Configure the recording settings here.

Sound system:
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Program settings

X
[ai tLi
Bl se_ ngs Sound system
¢ - Plug-ins

Add files
- User interface

= Sound system

= ;
Temporary folder ¥ find best output mode automatically

- Language Sl Bt A e
Auto update
- Record sound

- Confirmations
- CO{DYD Burner
Autosave

1 Windais Mullimedia

[= Panels Please note that changes ko the cutput mode take effect onby after restarting DiaShow,
Storyboard
Layout Designer
Timeline
Imagelist

|| Ok !| ‘| Cancel ‘| || Help ||

The Sound system takes on the task of playing back the music included in the slideshow. Should you have
irregularities when playing back the music, set the setting to Windows Multimedia here and then restart
AquaSoft ® SlideShow.

CD/DVD writer:

Program settings X
[ain setki F )
BhHains=tings CD/DVD Burner
| Plug-ins
¢ Addfiles = CD/D¥D-Burner
- User interface k¢
Temporary Folder |E: {PLDS DVD+-RW DH-16465 - YD12) 7]
- Language

Mote: For the use of the CODYD Function, administrative rights might be required with
Auto update windows XP[Vista]7. If vour CDJDYD writer is nok recognized, please try again with

R A adrninistrative rights.

Sound system I=| Burner settings

Witing speed: Sx (1408 KBfs) -

i Autosave
= Panels

- Storyboard
Layout Designer
Timeling
Imagelist

|| Ok !| ‘| Cancel ‘| || Help i

Here the recognized CD/DVD writers are shown.

Confirmation:
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Program settings X
() Main settings
: Flug-ins
Add files
- User interface
Temparary Folder
- Language | welcome Dialog
Auto update || Choose one or more images to be added with the template.
- Record sound [] Moke before starting the Direct® Player

Confirme

[=! Confirmations

Select dialogs to be shown:

Sound system

i Autosave
= Panels
Storyboard 1 Reset all dislogs 1

| shiows deactivated dislogs only

Layout Designer
Timeline
Imagelist

|| Ok !| ‘| Cancel ‘| || Help i

Select the dialogs to be shown here.

Automatic saving:

Program settings

g Autosave
Plug-ins
Add files = Autosave
- User interface
T fold Autnsave makes a copy of your current silde shows in equal intervals; the latest progress will
emporary folder nok be overwritten, Move the cursar over the menu item "File"="Restore” in order to return to
- Language a previous poink
Auto update e
| [l
et e [¥] Activate automatic saving
Sound system Maximum number of backup copies: 1a s
+ Confirmations i
CDJDVD Burner Inkervals between backups: 3 I | Minutes
L
= Panels I Delete all previous backups ||
- Storyboard
Layout Designer
Timeling
Imagelist
|| Ok !| ‘| Cancel ‘| || Help ||

Here you can determine whether backup copies should automatically be generated while you are working on a
slideshow. Under File -> Open -> Restore you can access an earlier status of your work.

Storyboard:
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Program settings
Storyhoard

=) Main settings
Flug-ins
Add files

- User interface

Temparary Folder
- Language
Auto update
- Record sound
Sound system
< Confirmations
- CO{DYD Burner

i Autosave
[ Panels

Layout Designer
Timeline
Imagelist

(=l Display

[#]Shaw file names under the thumbnails

= Additional settings

17 Show hiinks

|| Ok 1| ‘r Cancel 1| |r Help

1

Configure your settings for the Storyboard.

Layout Designer:

Program settings
Layout designer

in setbings

Plug-ins

Add files

- User interface
Temporary Folder

- Language

& Ma

Auto update
- Record sound
Sound system
+ Confirmations
- COfDVD Burner
i Autosave
B Panels
+ Storyboard
Layout
Timeline

Imagelist

=l Raster

Diefinie the settings for the rastat in the preview window.

Raster sizing:

Magnet strength; @ST:J
I=| Preview

Mazzimum number of objects ko be shown in the preview window, Maote: the higher the number
the longer loading the preview might take,

Ohbjects simultaneously:

|¥] For collages show only conkents

|| Ok 1| ‘r Cancel 1| |r Help

1

You can configure settings for the Layout Designer here.

Timeline:
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=) Main settings
Flug-ins
Add files

- User interface

Temparary Folder
- Language
Auto update
- Record sound
Sound system
< Confirmations
- CO{DYD Burner

i Autosave

[ Panels
Storyboard
Layout Designer

Imagelist

Program settings

[=! Music track

Height; [42 + | pixels 7| Hide music krack

i= Display

1| Show hinks

¥ 3how hundreths of a second

Style: iRounded v_|
1= Edit
|¥|Use other objects as snap guide ] Use time raster
Snap distance: o 2| pxel  Timeraster: [toomsec 2|
|l OK 1| ‘l Cancel 1| |l Help 1

Configure the settings of the Timeline here.

Image list:

in setbings

Plug-ins

Add files

- User interface
Temporary Folder

- Language

& Ma

Auto update
- Record sound
Sound system
+ Confirmations
- COfDVD Burner
i Autosave
B Panels
- Storyboard
Layout Designer
Timeling

Program settings
Image list

= Columns

Diefirie which columns should be shown in the object list,

1] Object
[ Start time
[¥1 Duration
[ File Size
[ File Diats
[ Settings
¥ Keywords
[ ExIF

[¥| File name
7] Slideshow
[ Track

|| Ok 1| ‘l Cancel 1| |l Help i

Here you can select which information should be displayed in the Image list.
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10 Technical information
10.1 Common preparations

Directories

In order to achieve a good result quickly and effectively, you can make some minor preparations in advance.
AquaSoft ® SlideShow saves an image list and, in that respect, keeps an eye on all directories specified.

Image format
AquaSoft ® SlideShow supports, inter alia, the following image formats.

.-’-'-.Ilas.-"-.?-.fave rl:unt Ellder [ la; rpf]

AM| Image [F.ani]

Artz & Letters Thumbnail Bilder [7.ged]
Autadesk Bilder [*.cel:” pic]

CompuSere Bilder [7.qif)

Drr. Hala Bilder [F.cut)

E ncapsulated Postzonipt Bilder [F epz]
Gerateunabhangige Windows bitmaps [*.dib]
JPEG 2000 [*jp2)

JPEG 2000 Codestream [*.jpc)

JPEG-Bilder [*.ffif:".jpe;". jpeq)

JPG Bilder [*.jpa)

K.odak Phaoto-CD Bilder [ ped]

Luraia! awe [ hwf]

tacintosh TIFF Bilder [* tiff]

Paintzhiop Pro Bilder [*,pzp]

Paintzhop Pro Frames [*.pfr]

Paintzhiop Pro Tubes [ tub]

PC TIF Bilder [ tif)

Photozhop Bilder [*.pdd;” psd]

Partable bitmap Bilder [*.pbm]

Partable gray map Bilder [*.pgm]

Partable network. graphic Bilder [*.png)
Partable pisel map Bilder [*.ppm]

Run length encoded “Windows bitmaps [.1lg]
SG1 schwarz/weizs Bilder [° b

SG1 True Color Bilder [*.rgb;" zgi]

S0l True Color Bilder mit Transparenz[ rghal
Truewsu:un Ehlu:ler [ |-:I:| tga vu:la vst wm]

As background sound the following file formats may be used:

A

.ﬁ.ll suppu:urtad fnrmats[ aiff

.-’-'-.dvanu:ed Streamlng Fu:urmat [ axf]
AlFF files [ aiff]

ITAmpulze Tracker-tMuzsic [*.it]
FOD-Muzic [* mad]

MP2 files [*.mpZ]

kP33 files [*.mp3]

QGG Yorbiz files [*.ogg)

S35 cream Tracker-busic [7.23m]
WA files [ wav]

YWindows Media Audio [* wma:™ wi]
=k FaztTracker-tuzic [F =m]

Al files [*.7] |
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Please note that MID and RMI files cannot be used when creating the video with the Video Wizard.

i Only use unencrypted music tracks for your slideshows. For legal reasons, AquaSoft ® SlideShow
does not support the use of music tracks which have been encrypted by DRM or similar procedures.

@

10.2 Installation

To install AquaSoft ® SlideShow we suggest at least the following system setup. More resources will lead to
higher quality playback:

Hardware

CPU-1GHz

Graphics board - DirectX 9c-compatible graphics board with 64 MB RAM for use of the DirectX-player. For
older graphics boards the Software-Player is available to play slideshows.

RAM - 512 MB

Harddrive - 150 MB (burning (S)Video-CDs may need space up to 1,2 GB for a short time, burning Video-
DVDs may take up to 10 GB temporarily)

CD/DVD-burner - (optional)

Operating system
Windows XP Home and Professional, Vista, Windows 7

not supported are the operating systems:
DOS, Windows 3.x, Windows 95, 98, ME, 2000, Unix, Linux, Apple Macintosh, Nowell, etc.

10.3 Full screen mode with different screen resolution

You can modify the graphic mode for the full screen display in the player settings. When switching the screen
resolution Windows can only assign a fixed or no frame rate at all. Since we can't know your graphics card/
monitor combination we omitted the assignment of a fixed frame rate. This was done to prevent any danger for
your monitor. Windows automatically switches to one of the possible modes, which you can change yourself.
(see Control panel -> Display -> Settings)

This hint is only of interest if you want to work with a modified full screen mode. The problem does not exist in
window mode.
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11  Ordering AquaSoft ® SlideShow

The easiest way to order a product by AquaSoft is to visit our Online Shop. Here you can always find the
newest offers and also bundles (combinations of several products), which you can save a lot of money with. In
addition you'll receive the newest updates.

12  Other programs by AquaSoft

AquaSoft SlideShow is just one of many useful programs created by AquaSoft. On the following pages you can
find additional programs with interesting features and useful enhancements.

12.1 AquaSoft ® Barbecue

The new image processing software AquaSoft ® Barbecue

NED DEL RSN
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The new image processing and managing software AquaSoft ® Barbecue is photo studio as well as image
factory. With just a few clicks you design your images yourself. The new built-in undo functionality makes
mistakes practically impossible. Macros are being created using the mouse - as easy as never before. All
steps in the process can be saved and are reusable for an unlimited amount of images. AquaSoft ®
Barbecue takes into consideration the development of digital photography. Therefore we integrated JPEG-2000
and the reading and writing of EXIF data. Thus AquaSoft ® Barbecue becomes a must for all owners of digital
cameras. An extensive manual in PDF format is waiting for you, as well.

Some features:

changing resolution and formats

evaluating EXIF data and their use as renaming information

static integration of water marks, stamps, logos, texts and own drawings into the image
zoom functionality

extensive image editing program

For instance you can convert hundreds of blue-cast, to dark 640x480 BMP images into colour corrected
320x200 JPEG images, for which you can set the compression rate, that are fit for the Internet. Especially the
integration of image editing, file conversion, the writing of JPEG2000 and Lurawave into an automated batch
conwversion makes it a program that the community has been waiting for for a long time.

In short, AquaSoft ® Barbecue is a batch-image-converter with image editing functionality.

More information on the Internet: www.barbecue.aguasoft.de
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12.2 AquaSoft ® DiscMenu
AquaSoft ® DiscMenu - Your professional CD-ROM-Publishing-System

b for e kg L e by s e
Limoin fuame, mit P AR i e g e i
e

You hawe the best contents but nobody looks at them? Endless amounts of data can be stored on CDs or
DVDs. But it needs a lot of care to make these data accessible to the user. What if you could organize the
contents of your CD through easily to create HTML-pages? Great idea! What's missing now is a suitable
environment because a normal web browser for displaying the page neither looks professional nor does it
provide the opportunities to customize its look. On top of that there are quite a few obstacles to overcome.
Good that there is AquaSoft ® DiscMenu.

The start menu for your CD or DVD:

¢ the auto-start menu for your installation file and other applications
the business card of your company with navigation

your product presentation on CD or DVD as adwertisement

the information system for your documentation

a new way for your multi-media application

You want to distribute eLearning-products or start eBooks, audio books, movie or sound files from CD?

AquaSoft ® DiscMenu provides the features of a multi-media authoring system!

More information on the Internet: www.aquasoft.net
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12.3 AquaSoft ® Multimediawerkstatt

Multimediawerkstatt - digital learning - a child's play
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AquaSoft ® Multimediawerkstatt is a software for playfully learning the use of computers and media.
Designed for children in grade school Multimediawerkstatt is an open creativity platform that combines
painting, writing, woice recording and presenting in one program.

Intuition and esprit - childlike fantasy burnt on CD
Due to its intuitive comprehensibility Multimediaw erkstatt is particularly suited for young students and users
without any computer experience. Almost in no time adventures are cast in digital format, and different
sources are connected to self-running presentations. Just like a slide show are the stories of our children
replayed on computer or burnt on an auto-starting CD. A multimedia software with esprit for school and leisure

time.

More information on the Internet: www.aquasoft.net

Copyright © AquaSoft GmbH 1999-2015


http://www.aquasoft.de/Multimediawerkstatt_Index.as

Other programs by AquaSoft 185

12.4 AquaSoft ® PhotoAlbum

AquaSoft ® PhotoAlbum - Get more out of your photographs

Digital photos are great but they aren't everything. You will come to a point where you wish you could look at
them in print. That's way you can say, paper photographs are alive and well.

With AquaSoft ® PhotoAlbum you can offer more than just lose photos to the admirers of your artwork. No
boring albums but exciting effects give your pictures center stage. Whether you want to spice up your desktop,
produce creative photo books or wake up your printer from its hibernation is up to you. In AquaSoft ®
PhotoAlbum everyone finds what is needed.

And these are the three easy steps:
e adding images

e selecting a template

e creating the photo album

AquaSoft ® PhotoAlbum already comes with many prepared templates. But with the integrated template
editor you can design your album to the smallest details yourself, as well. There are no limits. Title pages,
chapters, thumbnail view (contact print) and much more can be designed and positioned. Create professional
photo books just as easy as funny ones, e.g. with pictures that seem like pasted in.

Enough of always the same desktop wallpaper? With the integrated Desktop-Album you can revive the
memories of your last holidays. It's not just a simple one-after-the-other of your photos but they are
professionally embedded in an interesting environment.

More information on the Internet: www.aquasoft.net
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12.5 AquaSoft ® PhotoCalendar

AgquaSoft ® PhotoCalendar - Your photos, around the year.

S Photokalender

There's always a time to give gifts. So, what's more suitable than to give a calendar, then?

AquaSoft ® PhotoCalendar is a universal program for the creation of customized calendars. Ready-made
templates ensure the desired result with just a few clicks.

And these are the three easy steps:
e adding images

e selecting a template

e creating the photo calendar

AquaSoft ® PhotoCalendar already comes with many prepared templates. Calendars for printing or your
desktop, for giving away or keeping. Cover pages, any number of pictures per page, appointment books,
weekly, monthly, yearly calendars, etc. - leave room for your creativity. Create new calendar layouts to the
smallest detail with the help of the integrated template editor. Whether simple, advanced, funny or formal -
everything can be achieved in a professional manner.

Specify birthdays and appointments. Every event will be displayed with photos on the correct day.
PhotoCalendar also imports your appointments and birthday list from MS Outlook.

The DesktopCalendar brings your photos as a photo calendar to your desktop, including your specified events.
This too includes your MS Outlook events.

More information on the Internet: www.aguasoft.net
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12.6 AquaSoft ® ScreenShow

AquaSoft ® ScreenShow - Take a break and enjoy your pictures.

187

People always have been charmed by moving pictures. Put the magic of your photos on your screen. With
AquaSoft ® ScreenShow you can create your own photo screen savers with impressing transitions and
background music. And it can be done with just a few mouse-clicks. You can use these screen savers on

your own PC or you can distribute them, e.g. per eMail.

And these are the three easy steps:
e adding images

e entering a title

e creating the screen saver

More information on the Internet: www.aquasoft.net
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12.7 AquaSoft ® WebShow

AguaSoft ® WebShow - Waltzing from a photo to a website

While the Vienna Waltz uses three steps conwerts the program AquaSoft ® WebShow your photos into a
ready-to-go website. That's right! In just three steps a complete website is created including picture frames,
background, thumbnail navigation and, if you wish, transition effects.

And these are the three easy steps:

e adding images
e selecting a template
® launch the website

Whether for family or for presentations in the company, for you it is important to embed your photos and
pictures into a pleasing Internet site with just a few clicks. From the abundance of web templates you can
create a professional web project with oveniew page (thumbnails), navigation buttons and comments.

And those who want can dance the foxtrot. Then there is a fourth step available for setting the page properties
where all possible configuration can be made. E.g. you choose a picture frame, a certain background color, a
button style - even whole themes are available. Due to the powerful, XML-based scripting language of the
templates you can create your very own templates, as well. There are virtually no limits: you can use
everything that is supported bei HTML, PHP, ASP, Javascript etc. Again, you can but you don't have to.
Because AguaSoft ® WebShow has almost everything prepared for you.

More information on the Internet: www.aquasoft.net
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13

13.1

AquaSoft ®

If you have problems

The AguaSoft-homepage offers software on the topics of education, image editing and image management as
well as further shareware and freeware for download.

Visit our homepage at www.aquasoft.net. You will find downloads, FAQ, forums and information on our
products.

If you have trouble with an AquaSoft product or questions, criticism, praise, please proceed as follows:

Check the manual or the according help file.
Try finding an answer in the FAQ (Frequently Asked Questions).

Visit the respectivee forum. There users can exchange experiences and can ask questions. Write your
own entry. Sometimes it is easier for another user to understand the question than for a whole team of
dewelopers - and the answer might come quicker, too.

Only after those steps didn't succeed, write or call us. We take your suggestions as important help, but
we also need time to advance the software.

The contact email address is: info@aquasoft.de
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